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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©September 2010

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive

Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, L ux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia

CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)
Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.

11l
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.

\ A/
2§
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-

pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 -
240V, 50 - 60Hz DC Output 20V, 15A (300W) minimum).

This Computer’s Optical Device is a Laser Class 1 Product
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1. Don’tdrop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.
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Do not placeit on an unstable
surface.
4
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Do not place anything heavy
on the computer.

2. Keep itdry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.
Do not expose it to excessive Do not leaveit in a place where
heat or direct sunlight. foreign matter or moisture may
affect the system.
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Don't use or store the computer Do not place the computer on
in a humid environment. any surface that will block the

\ents/Fan I ntakes.
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S
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other

strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power until
you properly shut down all pro-
grams.

Do not turn off any peripheral
devices when the computer is
on.

{ ol R

&®

Do not disassemble the com-
puter by yourself.

EPs
Ce

Perform routine maintenance
on your compulter.

5.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

@A

Unplug the power cord before
attaching peripheral devices.

Y o>
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Power Safety

The computer has specific power requirements:

\ A/
2§
Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.

VI

 Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requires a steadly,
uninterrupted power supply. If you are unsure of your local power specifications, consult

your service representative or local power company.

» The power adapter may have either a 2-prong or a 3-prong grounded plug. Thethird prong

isan important safety feature; do not defeat its purpose. If you do not have accessto a

compatible outlet, have a qualified electrician install one.
» When you want to unplug the power cord, be sure to disconnect it by the plug head, not by

itswire.

» Make sure the socket and any extension cord(s) you use can support the total current load
of al the connected devices.
« Before cleaning the computer, make sure it is disconnected from any external power sup-

plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power
cord if you are wet.

Do not use the power cord if
it is broken.

WogeD

®

Do not place heavy objects
on the power cord.

i
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Polymer Battery Precautions

Note the following information which is specific to polymer batteries only, and where applicable, this overrides

the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.
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General Battery Precautions

» Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

» Do not remove any batteries from the computer while it is powered on.

» Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

» If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Donot try to repair abattery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of adamaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

When the power cord or AC/DC adapter is damaged or frayed.

If the computer has been exposed to rain or other liquids.

If the computer does not work normally when you follow the operating instructions.

If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
If thereis an unusual odor, heat or smoke coming from your computer.

SN
L&

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your “papers” are handy.

\ A/
ALK
Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer

agprwbPE

N o

from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

Xl
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XMl
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
afootrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times aday.

Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

Cable TV Safety
If you haveincluded aTV Tuner in your purchase option then pay careful attention to the following:

Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the
building, as close to the point of cable entry as practical.

Thisreminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part
| of the Canadian Electrical Code).

The TV antenna supplied with any TV Tuner module isintended for indoor use only. Please do not use your TV Tuner
modul e outdoors.

XV
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, card reader), TouchPad & Mouse, Audio Features & Printer.

e Chapter 3  The computer’s power management options.

» Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructionsfor upgrading your computer.

» Chapter 7 A quick guide to the computer’s RAID, Bluetooth, WirelessLAN, PC Camera, TV Tuner,
Turbo Memory, HDMI-In and Finger print modules (some of which may be optional depending
on your purchase configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on the NVIDIA Video driver controls.

» Appendix C The computer’s specification.

Mustang W650 Notebook Overview 1 -1



Quick Start Guide

Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
torefer to “Drivers & Ultilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “ Upgrading The Computer”
on page 6 - 1 inthe User’s Manual. Y ou may also find the notes marked with a ~# of interest to you.

Beginners and Not-So-Advanced Users

4 If you are new to computers (or do not have an advanced knowledge of them) then
Notes the information contained in this Quick Start Guide should be enough to get you up
. and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the

boxes with the mark '
above to find detailed remainder of the User’s Manual), but do not worry if you do not understand every-
information about the || thing the first time. Keep this manual nearby and refer to it to learn as you go. You
computer’s features. may find it useful to refer to the notes marked with a # as indicated in the margin.
For amore detailed description of any of the interface ports and jacks see“ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overvl?,l\(}gtang W650 Notebook



Quick Start Guide
Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.

Mustang W650 Notebook Overview 1 -3
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" System Software

7£l< Y our computer may aready come with system software pre-installed. Where thisis

TV Tuner Module not the case, or where you are re-configuring your computer for a different system,
Support you will find the Windows 7 operating system is supported.

Note that the TV Tuner
module (factory) option
is supported by the Win-

Note: In order to run Windows 7 without limitations or decreased performance, your
computer requires a minimum 1GB of system memory (RAM).
dows Media Center

SCEICREEIERIESE RAID & AHCI Setup

g:ja i(;egttzrrtfrng: 'ﬂgumdé Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the

SRl e e el Windows OS (see “ Setting Up SATA RAID Mode’ on page 7 - 2).
dows 7.

1-4 Overvl‘]?,l\(}gtang W650 Notebook



System Startup

1.
2.
3.

Quick Start Guide
Remove all packing materials, and place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use
the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the
computer by the lid/LCD).

Raise the lid/LCD to a comfortable viewing angle, and press the power button.

4

Shutdown

Note that you should always shut your computer down by choos-
ing the Shut Down command from the Start menu in Windows 7.
This will help prevent hard disk or system problems.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD

Mustang W650 Notebook SyStem Startup 1-5



Quick Start Guide

Figure 1 - 2 System Map: LCD Panel Open & Top View
LCD Panel Open
& Top View L%

1. Built-In PC Camera Wireless Device
2. Built-In Microphone Operation Aboard
3. LCD Aircraft
4. LED Status Indicators
5. Touch Sensor Instant The use of any portable elec-
K tronic transmission devices (e.g.
eys WLAN or Bluetooth) aboard air-
6. Speakers craft is usually prohibited. Make
7. Power Button sure any wireless modules are
8. Keyboard OFF if you are using the comput-
9. TouchPad and 2 er aboard aircraft.
Buttons Use the appropriate function key
10. Fingerprint Reader : combination to toggle power to
Modul any wireless modules, and
. check the indicators to see if any
11. LCD Panel Color ; iR modules are powered on or not
LED (see ).

1-6 Systenhmaargv}&%lao@%&el Open & Top View



LED Indicators
The LED indicators display helpful information about
the current status of the computer.

Icon Color Description

El Blue Scroll Lock is Activated
Blue Caps Lock is Activated
&l Blue Number Lock is Activated
Blinking Blue Hard Disk Activity

Table 1 -1 - LED Status Indicators

Quick Start Guide

Ilcon

Color

Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking The Computer is In Sleep Mode

Green

Orange The Battery is Charging

Blinking The Battery has Reached
m Orange Critically Low Power Status

Green The Battery is Fully Charged

Table 1 -2 - LED Power Indicators

Mustang W650 Notebook
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Touch Sensor Instant Keys

Press the Touch Sensor Instant Keys on the computer to toggle the appropriate function on/off. When amodule
is powered on the appropriate icon will be highlighted blue.

Icon Description

Mute Toggle

Bluetooth Module (optional) Power Toggle

Wireless LAN Module (optional) Power Toggle

Make sure that Wireless is ON in the Windows Mobility Center to ensure proper wireless instant
key behavior (see page 3 - 11).

PC Camera Module Power Toggle

Volume Control (Press and hold your finger at either end \/=/\/+ of the volume control

V= wnnnonnnnnn it i V+ to adjust the system volume)

Table 1 - 3 - Touch Sensor Instant Keys

Note that you can also use the function key combinations for all of the functions above (see page 1 - 10).

1-8Touch &ens rGLrgﬁtaQt Keys
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Keyboard

The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operationa features instantly. See
Table1 -4, on page 1 - 10 for full function key combination details.

M (Mg (Mg (Mg Function Keys s e (M - "..l =4 i II'-’ -

5 i " . & | & - i ] . « wNumLk &
i I =] i | £l 5 ] T n -] ] 1 = SCka Keys

Play/Pause Key [ [+ T W i o Fo i i t n ¥
A I I I rimm T el
e L T L .- ] " ot “Nunferical

: “Keypad ~

i A o L e - l‘:- b i .rv T 1
& - . B . n ¥ " o i

Fn Key

Figure 1 - 3 - Keyboard

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Quick Start Guide

4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Num Lk & Scr Lk

Hold down the Fn Key
and Scr Lk/Num Lk to en-
able scroll lock/number
lock, and check the LED
indicator for status.

Mustang W650 Notebook
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Function Keys & Visual Indicators

Thefunction keys (F1 - F12 etc.) will act ashot keys when pressed while the Fn key isheld down. In addition to the
basic function key combinations; visual indicators (see the table below) are available when the Hot Key driver isin-
stalled (see “Hot Key” on page 4 - 7). After installing the driver an icon i will appear in the taskbar.

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn +~ Play/Pause (in Audio/Video Programs) Fn +F8/F9 Brightness Decrease/ iﬁ] .ﬁ'“,r'
Increase ‘|
= PC Camera Power
Fn+F1 Touchpad Toggle 3 ) 6{., Fn + F10 Toggle ‘m m

i * = =
Fn+F2 Turn LCD Backlight Off Fn+ F1L WLAN Module ~ a k= '
use Touchpad to turn on) Power Toggle ] |

(Press a key to or

2 r a '\-‘ e
Fn+F3 Mute Toggle wjl w ! _J Fn + F12 B|g§$z:h_rcl\)/g;ctle = ~u-

Fn + NumLk Number Lock Toggle

L

Fn + F4 Sleep Toggle
-, i
Fn +F5/F6 Volume Decrease/ aﬁ 3(-) Fn + ScrLk Scroll Lock Toggle
Increase - —
]
Fn + F7 Display Toggle - DO NOT use when SLI is enabled Fn+5 Audio Toggle - Toggle between Stereo and 5.1 Sur-
round Sound Modes

*Make sure that Wirelessis ON in the Windows M obility Center to ensure proper wireless function key behavior (see page 3 - 12).

Table 1 - 4 - Function Keys & Visual Indicators

1-10 Keybcg/lard
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Quick Start Guide

Figure 1-4
Front View

1. Consumer Infrared
Transceiver
(enabled with
optional TV Tuner
only)

2. LED Power
Indicators

3. DC-InJack

4. Vent/Fan Intake

SN
ALK

TV Tuner Module Support

Note that the TV Tuner module (factory) option is supported by the Windows Media Cen-
ter software. Windows Media Center is not included in Starter or Home Basic versions
of Windows 7.

MUstang W650 Notebook System Map: Front & Rear Views 1 - 11



Quick Start Guide

Figure 1- 5 System Map: Right View

Right View

Line-In Jack
S/PDIF-Out Jack
Microphone-In Jack
Headphone-In Jack
3 *USB 2.0 Ports
Security Lock Slot

ogahrwNE

USB Ports

Note that the connections to the USB ports only fit one way, do not force them.

4

USB 2.0 or 3.0 Ports
USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.

1-12 Systemsl\a{ln%%gi peL View
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System Map: Left View

USB 3.0 Ports

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. Note that
the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7), does not
support wake on USB and is not operational under DOS.
9-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible
MS (Memory Stick) / MS Pro / MS Duo

HDMI Ports

Note that the HDMI Ports support video and audio signals to attached external displays

(also see “HDMI Ports™ on page 2 - 7). The HDMI-In port is enabled with the optional
(Factory Option) HDMI-In Module only.

Mustang W650 Notebook

Quick Start Guide

Figure 1 -6
Left View

1. Speaker

2. DVI-Out Port

3. Cable (CATV)
Antenna Jack®

4. RJ-45 LAN Jack

5. HDMI-Out Port

6. 2*USB 3.0 Ports

7. eSATA Port

8. Mini-IEEE 1394b Port

9. HDMI-In Port
(Factory Option)

10. 9-in-1 Card Reader

11. Optical Device Drive
Bay

*Enabled with Optional
Mini-PCI TV Tuner Only

4

Mini-IEEE 1394b Port

The Mini-IEEE 1394b port
only supports SELF POW-

ERED IEEE 1394 devices.

System Map: Left View 1 - 13
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

1- 14 Systef Map; L&ft View

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.




Quick Start Guide

System Map: Bottom View Figure 1- 7

Bottom View

=

Sub Woofer

Fan Outlet/Intake

3. Component Bay
Cover

4. Battery
(Secondary HDD
Bay - HDD3)

5. Primary HDD Bay

(HDD1 & 2)

n

Overheating

4
To prevent your comput-
Battery Information er from overheating make
sure nothing blocks the

Always completely discharge, then fully charge, a new battery before using it. Completely vent(s)/fan intake(s)
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 10 for full instructions. use.

while the computer is in

Mustang W650 Notebook System Map: Bottom View 1 - 15
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Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usualy be placed in the Start menu and/or the desktop. Right-click the Start menu
icon [, and then select Propertiesif you want to customize the appearance of the Start menu.

T N

Frassrisn

Oyt Wiresows Sapd osgy
.

|

[ 4]

-.-.!l"

. - N

. . -

Tl X E L3

- # >

- CIiQ'k here to tpggle Cate_gory View
| ]

Figure 1 - 8 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
inWindows (e.g. power, video, network, audio etc.). Windows 7 provides basic controlsfor many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

1-16 Windqﬂws 7%&%&&; enu & Control Panel
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Quick Start Guide
Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Per sonalization) in Windows 7.

To access Display (Control Panel) and Screen Resolution in Windows:

1. Click Start and click Control Panel.

2. Click Display (icon) - In the Appearances and Personalization category.

3. Click Adjust Screen Resolution/Adjust resolution.

OR

4. Alternatively you can right-click the desktop and select Screen resolution @ (Figure 1 - 9 on page 1 - 18).
5. Use the dropbox to select the screen Resolution @ (Figure 1 - 9 on page 1 - 18).

6. Click Advanced settings @ (Figure 1 - 9 on page 1 - 18) to bring up the Advanced properties tabs.

4

NVIDIA Video Controls

More detailed video controls are provided by the NVIDIA Control Panel. For more detailed information see Appendix B.

You can also access the control panels by right-clicking the desktop and selecting NVIDIA Control Panel/Catalyst (TM)
Control Center @) (Figure 1 -9 on page 1 - 18).

Mustang W650 Notebook Video Features 1 - 17
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Screen Resolution

4

Video Options

Note that card types, specifica-
tions and drivers are subject to
continual updates and changes.
Check with your service center
for the latest details on video
cards supported.

Vimw "
Sper by .
Fafrizh

[ ]

Py G el

KR S il Bl @R

Srmmen reschon
B Gadges
@ o=

I

1-18 Video Features oo
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Figure 1 - 9 - Screen Resolution
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NVIDIA Control Panel
Y ou can access the NVIDIA Control Panel asfollows:
1. Click Start, and click Control Panel.

2. Click NVIDIA Control Panel @ (Figure 1 - 10) - In the Appearances and Personalization category.
3. See “NVIDIA Video Driver Controls” on page B - 1 for full details on control panels etc.

OR
4. Click Advanced settings @ (Figure 1 - 9 on page 1 - 18) in the Screen Resolution control panel in
Windows.

5. Click GeForce (tab) and click Start the NVIDIA Control Panel @.
|;. - .-._.-.-_- | m-.-u__amﬂm — .___ oo

b '] a = |

- :

: ; - Lashag =y re | N0 Druae Lims M

Y 4 ey T e ik
l @ R e b )

Figure 1 - 10 - NVIDIA Control Panel
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Power Options

The Power Options (Hardwar e and Sound menu) control panel icon in Windows (see page 1 - 16) alowsyou
to configure power management features for your computer. Y ou can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create anew plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “ Battery Information” on page 3 - 10.

—

e = i Pervsr Dyt & Systw St L [=

it e e hirse ey bist b sl by oo passviered profsctimn

B e r——

Figure 1 - 11 - Power Options

1-20 Power Options
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Storage Devices, Mouse, Audio & Printer

Chapter 2. Storage Devices, Mouse, Audio &
Printer

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical Device

9-in-1 Card Reader

HDMI Ports

Audio Features

TouchPad and Buttons/M ouse
Adding a Printer

Mustang W650 Notebook Overview 2 - 1



Storage Devices, Mouse, Audio & Printer

Hard Disk Drive

\ A/

’I'l‘ The hard disk drive(s) issuer) used to store your data in the computer. The hard
Power Safety disks) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives

S e o withaheight of 9.5 mm. The primary hard disk bay @ is accessible from the bottom

Sees el of your computer as seen below, and the secondary hard disk bay @ islocated under

CelyenER IS the battery compartment.

computer please ensure

UEEGERNECIERERIGSE  The computer can accommodate up to three hard disks (two in the primary bay, and
S e S onein the secondary bay), and these may be configured in RAID or AHCI modes.

power, and that the ma- . . . . . . - .
SN\ | Further details on removing and inserting the hard disk are availablein “ Upgrading

SRR s the Hard Disk Drive(s)” on page6 - 4.
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure2-1
Hard Disk Location

2 - 2 Hard HJ&%Q rQ!é/oeNotebook



Storage Devices, Mouse, Audio & Printer

Optical Device

Thereisabay for a5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “ Storage” on page C - 2). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set inthe BIOS (see “Boot Menu” on page 5 - 15).

Loading Discs

Toinsert aCD/DVD, press the open button @ and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until itslock “clicks’ and you
are ready to start. The busy indicator @ will light up while data is being accessed,
or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency gject hole
© to open thetray.

.|
Optical Device 2 - 3

Mustang W650 Notebook

4

Sound Volume
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-

ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting.

Peripherals must be
connected before you
turn on the system.

Figure2- 2

Optical Device
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Handling CDs or DVDs

\ A/

ﬂ: Proper handling of your CDS/DVDs will prevent them from being damaged. Please
follow the advice bel ow to make sure that the data stored on your CDS/DV Ds can be

CD Emergency Eject
accessed.

If you need to manually

S iR e RETERCER  Note the following:
an unexpected power

LICERT IS CEER eV« Hold the CD or DVD by the edges; do not touch the surface of the disc.
SSERRER SN RSRERE  «  Use aclean, soft, dry cloth to remove dust or fingerprints.
fg[?'g}fiﬁgrg%ii?ejce“g « Do not write on the surface with a pen.

e SEeE el ¢ Do not attach paper or other materialsto the surface of the disc.
SNeRETEEE R ETEl o Do not store or place the CD or DVD in high-temperature areas.
SUEERCEEIRE SR UIERE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
COLERE SRS« Do not bend the CD or DVD.

db lodged i .
;ne hoﬁfome =8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

e
2 -4 OptICﬁLSQ%V\A,%&) Notebook



DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes’ on

Storage Devices, Mouse, Audio & Printer

page 1l - 14.
DVD Regional Coding
Region Geographical Location [T LT S T W2
1 USA, Canada
2 Western Europe, Japan, South

Africa, Middle East & Egypt

South-East Asia, Taiwan, South

3 Korea, The Philippines, Indonesia,
Hong Kong
4 South & Central America, Mexico,
Australia, New Zealand
5 N Korea, Russia, Eastern Europe,
India & Most of Africa
6 China

Table2-1
DVD Regional Coding

Mustang W650 Notebook
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Storage Devices, Mouse, Audio & Printer

4

Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

Figure2-3
Right View

1. Card Reader

O9-in-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see” Card Reader” on page 4 - 6).

+ MMC (MultiMedia Card) / RSMMC
* SD (SecureDigital) / Mini SD / SDHC / SDXC Compatible
e MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

2-6 g'in'lmﬁ%ﬂgﬁg 0% 0ok



Storage Devices, Mouse, Audio & Printer

HDMI Ports

This computer has an HDMI (High-Definition Multimedia Interface) output port,
and also features an optional HDM | input port (the HDMI-1n moduleisa Facto-
ry Option). HDMI is a compact audio/video interface for transmitting un com-
pressed digital data.

e The HDMI-Out port alows you to display and hear video/audio sources from
your computer to digital Teffs, displays or audio systems that support an HDMI
input.

* Theoptional HDMI-In module allows you to display external sources such as
Blue-ray players, DV Ds, set top boxes and games consoles etc. on your com-
puter screen.

See “NVIDIA Video Driver Controls’ from page B - 1 for information on setting
up external displays connected to the HDMI-Out port.

Make sureyouinstall the HDMI-Indriver in order to support any HDMI input sourc-
esif you have included the optional HDMI-In module in your purchase configura-
tion. When the HDMI-In driver isinstalled the Game M ate M edia Player will be
installed (see “HDMI-In Module” on page 7 - 51 for more information on the ap-
plication etc.).

Mustang W650 Notebook HDMI Ports 2 - 7
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5 HDMI Audio Configuration
AsHDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you can configure the audio output as per the instructions below.

Audio Setup for HDMI

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Click Playback (tab), and click to select Realtek Digital Output.

Click Set Default (button).

Click OK to close the Sound  control panel.

Select Speakers as the default for standard audio sources.

ok wppE

et | Bomory | b | Sy

1L i e Tl blmer Lo O 2y B P g

Figure2-4
Sound Playback
Options
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Audio Setup for LCD Monitors/TVs with HDMI Input

Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital
audio decoders. Where this is the case, when playing DVDs in Windows Media
Player/CyberLink Power DV D, a background noise can occur. If this situation does
arise then please follow the instructions below.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Double-click Realtek Digital Output.

Click Supported Formats (tab).

Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
Click OK and close the control panels.

ok wnE

e e

=1 mmirar s Wi rwrey
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Figure2-5
Sound
Supported Formats
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4

Other Applications

If you are using a third
party application to play
DVDs etc. you will need
to consult the applica-
tion’s documentation to
see the appropriate au-
dio configuration (the
application must support
digital to analog transla-
tion).

2 -10 HDI\/M Por

HDMI Notes

Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

If you disconnect the HDMI cable the default audio playback device will not
revert to speakers until the computer isrestarted (if you do not wish to restart the
computer then go to the Sound control panel and select Speaker s as the default
audio playback device).

HDMI Video Configuration

1.
2.

3.

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Configuring an
External Display using the NVIDIA Control Panel” on page B - 7.

Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

You can now play video/audio sources through your external display.

ustang W650 Notebook
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Audio Features

Y ou can configure the audio options on your computer from the Sound  control

4

panel in Windows, or from the Realtek HD Audio Manager [ icon in the taskbar/ SO Vo Ui
Adjustment

control panel (right-click the taskbar icon g to bring up an audio menu). Thevolume
may also be adjusted by means of the Fn + F5/F6 key combination or by pressing | The sound volume level

your finger on either end of the Touch Sensor volume control (see Table1 - 3, on | Is set using the volume
page 1 - 8) control within Windows

' (and the volume func-
Ehemee— S tion keys on the comput-
| ::] Sound Mansger it (], — 7 e T er). Click the volume
icon in the taskbar to

vy sl Deovces || B i check the setting.
K —— e i megesn e e LR .' '
% Sysham Sourd Evennis G ) K | :1

il.n-_j] Windows Heds Pl S r—:—"_\ A
_ | &

Wiphires Candnal

J: Suind Revo ke  ntnniniid

e a

Right-click the icon§il
to access the menu

above. B HEsTEx i
Figure2-6
See “HDMI Audio Configuration” on page 2 - 8 for a description of the audio configuration Realtek Audio
when connecting an HDMI supported display device. Manager
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-

tions below:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel)
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon ﬂ and select
Sound Manager).

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4.

Figure2-7
Realtek Audio
Manager -
Recording Setup

Click OK to close the control panel and save the settings.

5 nraamre ]
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Setup for 5.1 or 7.1 Surround Sound

\ A/
To setup your system for 5.1 or 7.1 surround sound you will need to connect the au- 7&‘
dio cables to the Headphone-Out, Line-In, Microphone-In jack and SPDIF-Out BE=ER NI TS el o)1=

jacks (note: the SPDIF jack is used for 7.1 surround sound only) . Y R p—

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) nation allows you to tog-
and make sure you are in Classic View. gle the audio system
2. Click Realtek HD Audio Manager (or right-click the taskbar icon H and select between stereo and sur-
Sound Manager). round modes. The ste-
3. Click Speakers (tab) and click Speaker Configuration (tab). reo mode will allow for a
4. Select5.1 or 7.1 Speaker from the Speaker Configuration pull-down menu. louder audio volume.

Note that if you have
stereo mode enabled,
and attempt to demo the
speaker configuration,
then the sound will only
be enabled through the
front and rear speakers.

4

Auto Popup Dialog

U e P s " mme CoONnector SettingsEma™=
¢ - \gs
W i ﬁ 3 -

L N You should enable the
[ N auto popup dialog to au-
tomatically detect when a
device has been

. plugged-in. If disabled,
double-click connector
settings | and click the Figure2- 8
box to enable the auto Speaker
popup  detection  of . .
plugged-n devices. Configuration (7.1)
i
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Figure2-9
Connected Device
Auto Popup

o

~

©

Plug the front speaker cables into the Headphone-Out Jack.
Plug in the other cables (you may require an adapter to connect each cable to the

appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as

follows:

Line-In Jack = Rear Speaker Out
Microphone-In Jack = Center/Subwoofer Speaker Out
S/PDIF-Out Jack = Side Speaker Out (for 7.1 Surround Sound Only)

As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on
page 2 - 13).
Click to put a tick in the appropriate box according to the speaker plugged-in (e.qg.

Rear Speaker Out), and then click OK to save the setting.

TR
¥ 1
FRET L
oy

-,

rai

B e I N e

-

—=

i"-_—v-. b = .

- e bl L =T

Click OK to exit Realtek HD Audio Manager.

b el Lkl

Lo s e sameeand v wr e

Lo RN e el o T D]

Note: Side Speaker Out is required for 7.1 Surround only.
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Dolby Settings
Y ou can adjust the Dolby settings from the Dolby tab in Speakers Properties.
Click Start, and click Control Panel (or point to Settings and click Control Panel).

ok wbpE

Click Sound (Hardware and Sound).

Click Playback (tab).

Double-click Speakers (or select Properties from the right-click menu).
Click Dolby (tab)

Adjust the settings to your preferences and click OK.

el By | et | O

ol D B AL L DO B I R TR

B =i
-

Fyptgs, [ngaw Cojopan
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Figure2- 10
Speakers Properties
Dolby Settings
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add amouse to
your computer through one of the USB ports. The TouchPad buttons function in

If you are using an ex- much the same way as a two-button mouse.
ternal mouse your op-
erating system may be
able to auto-configure

Mouse Driver

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’'s user docu-
mentation for details.

2 - 16 Tou%pPadw%Qo%Q%ttons/Mouse
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Once you have installed the TouchPad driver (see “ TouchPad” on page4 - 7) you
can configure the functions from the Mouse control panel in Windows, or by double-

clicking the TouchPad driver icon

on the taskbar. Y ou may then configure the

TouchPad tapping, buttons, scrolling, pointer motion and sensitivity optionsto your
preferences. Y ou will find further information at www.synaptics.com.

ESon poslguren
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TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

Figure2- 11
Mouse Properties
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Gestures and Device Settings

4 . The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
Show Video tion) on the surface of the TouchPad to perform specific actions to manipul ate doc-
You can get a clearer uments, Obj ectsand applications
view of the gestures in-

volved by clicking the |y o) can configure the settings from the Device Settings tab in M ouse Properties:
Show Video option for

each gesture item. 1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
Sl 1o GRS (R 2 Cl!ck Mou_se (HarQware and Soupd). _

Zoom, Rotating, Three 3. Click Device Settings (tab) and click Settings.

Fingers Down and 4. Use the menu tree on the left to access the user configurable settings.

Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the

right menu window. iy
R el
by iy i e Wi
i L o L [ TR T ' i B8 ool s B i e e o
3 k o e e s B e o S
" e TS B aamd kit o= o et el et 1 v o med v, B
Flgure 2-12 :’."‘ ..-_.‘?‘.! piplerid it oLl i
. =l i B T [E R e
Mouse Properties - —=
Device Settings e | ey B
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Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingersin the direction required (in a straight con-
tinuous motion).

Figure2- 13
Scrolling Gesture

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

VR Figure2- 14

Zooming Gesture
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Figure2 - 15
Rotating Gesture

Figure2 - 16
Flick/Press
Gesture

Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Nh

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

2 -20 Tou%sl?aggw%goq\lgléttons/Mouse
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

1.

aprwdn

Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-
tridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer's USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer

Thisisstill avery common type of printer. Theinstall instructions are in the sidebar
(you will need to purchase a parallel to USB converter).

Adding a Printer 2 - 21
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Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer's
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on your

) ] more information it is
This chapter covers: best to refer to the user’s
manual of your operat-
» The Power Sources :
i ing system.
* Turning On the Computer
* Power Plans (Note: All pictures used
. Power-Saving States on the following pages
. . f the Wind 7
» Configuring the Power Buttons grg )rom e Windows

» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

Mustang W650 Notebook Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components (see page C - 4).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see“How do | completely discharge the battery?”

on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 10.

3 -2 The Phs?u\é\{%%%%ces
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Turning On the Computer P

Now you are ready to begin using your computer. To turnit on simply pressthe pow-
er button on the front panel. Forced Off

; ; If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ i s G 2 T ]

Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and | ey combination doesn't
holding the power button for longer than this will shut the computer down). Use || work, press the power

Power Optionsin the Windows control panel to configure this feature. button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

4
Power Button as
Shut Down Stand by or

Note that you should always shut your computer down by choosing the Shut Down com- Hibernate Button

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk You can use the OS's
or system problems. Power Options control
Codich Liser panel to set the power

Dhaslausht F.'._'-;:.:.n button to send the Sys-

L:':I. off tem into Stand by or Hi-

Lok bernate mode (see your
OS'’s documentation, or

Help and Suppo

Restart gt

5 “Configuring the Pow-
Shesp er Buttons” on page 3
T, AL - 8 for details).
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Power Plans

The computer can be configured to conserve power by means of power plans. You

4

Resuming can use (or modify) an existing power plan, or create a new one.
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

see Tables - L ON | 14 send the computer into Sleep after aperiod of inactivity.

page 3 - 9 for informa-

tion on how to resume . . . .
GEm A e Click Change plan settings and then click Change advanced power settings to ac-

. cess further configuration options in Advanced Settings.

Password

It is recommended that e e e .
you enable a password bt st ¥ AT o i ek et S ot
on system resume in or- i - [ L
der to protect your data. = -

Figure3-1

Power Plan R e
Advanced Settings < > . o e o

(Win 7)
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High performance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save

power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide : St vyl
additional

power pl ans\

Mustang W650 Notebook
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Figure3- 2
Power Plans (Win 7)
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Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Win 7 uses the Sleep, Hiber nate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save al the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3-6 Powe{A-Savi\wegsO%ta es
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Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occursthe system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. Y ou should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Swnlch Use
Logoff Win 7
Lock

[hefazilt Pr (T

Hadp amd
Restart

P s~y Sleup

(Shot dawn ' »
\ Hibermats

.|
Power-Saving States 3 - 7
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Figure3-3
Start Menu Power
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Configuring the Power Buttons

Z The power/deep button (Fn + F4 key combo) and closed lid may be set to send the
Password computer in to a power-saving state. Click Choose what the power buttonsdo on
Protection the left menu in Power Options to bring up the menu.

It is recommended that
you enable a password T T ——" ik
on wake up in order to
pl’OteCt your data. [ hrep ewdeny bt torrm mnid funme nn passatierc probectimn
Dk T pow | e e frarl yu em e yoa comzaan. M cAsrpen =0 Tl D B9 w0 B

However you can dis- o o
able this setting from the o s
Power Options menu j oveem o
by clicking Require a @ i i bt = =
password on wakeup T : ’
in the left menu, and se- ‘3 WHES ] s T S Dok e $oyp *
lecting the options (click " Spram——— P = = -
Change settings that
are currently unavail- S (U .
able). bl e

Y e I AT N DAL Pl O 0 0 B e’ AT DRl A Ll TR TR

il ek Pl

Figure3-4
POWGr Options :.'_.:.;-... T T LT R R T e T TR = T T F R T To Sy |
Define Power
Buttons T
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Resuming Operation

Y ou can resume operation from power-saving states by pressing the power button, Z
or in some cases pressing the sleep button (Fn + F4 key combo). Closing the Lid
If you have chosen to
Power Status Icon Color To Resume send the computer to
Sleep when the lid is
Power Off Off Press the Power Button closed, raising the lid

Press the Power Button SIE SR EEm U

Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery) Table3-1
Hibernate Press the Power Button Resuming
Orange (AC/DC adapter) .
Operation
Display Turned Off Green Press a Key or Move the Mouse/Touchpad
4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Mustang W650 Notebook Configuring the Power Buttons 3 - 9
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Battery Information

\ A/
’Ll‘ Follow these simple guidelines to get the best use out of your battery.
Low Battery
Warning Battery Power

Whenihe bareryis oriti Y our computer’s bqttery power .is dependerjt upon many factors, includi ng the pro-
VA e @ grams you are running, and peripheral devices attached. You can set actions to be
ceuEes GER Aeel  taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
SCERERCEREEIE A power plan Change plan settings > Change advanced power settings (see Figure

or save your work, oth- ) _
erwise, the unsaved 3-1onpage3 4) ’

fhata VR UERE  Click the battery icon [ in the taskbar to see the current battery level and charge
e power is depleted.

status.
L& EL% remainng
LT N R PR
. @ Raarcad

Flgure 3-5 Povwll Bavias

Battery Icon
(Taskbar) & Battery e
Advanced Settings R
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Conserving Battery Power

» Useapower plan that conserves power (e.g Power saver), however note that
this may have an affect on computer performance.

» Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.

» Reduce the amount of time before the display is turned off.

» Closewireless, Bluetooth, modem or communication applications when they are
not being used.

» Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

FW J

] Cepla e F1% rerriainir Cnnnect H ili
Bl e | Dl B s | ] Conneetes Windows Mobility
- & Center
L} e _—-_|— Pty Custorni Planl o= ||

The Windows Mobili-

Erighines Yokamne Bpftery Stabus

o diplay [P J ty Center control pan-
l" rormected @ Anerhig gl torpremeiog .
3y Lo, el provides an easy
| Comecasiey | | smestogs | | Twmen point of access for in-
formation on battery
Extepraal Dlisp bay Sypc Conter Bresartation Settrgs

status, power plans
used and wireless de-
vice status etc.

Make sure Wireless is ON to ensure proper function key behavior.

Mustang W650 Notebook
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SN
L&

Wireless Hot Keys

The computer's wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
ESE# may show that
the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on.

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure3-6
Windows Mobility
Center
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Battery Life

Battery life may be shortened through improper maintenance. To optimizethelife

and improveits performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
movethe battery for any reason (e.g. long term storage) see “ Removing the Battery”
on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. (Refer to“ LED Indica-
tors’ on page 1 - 7 for information on the battery charge status, and to “ Battery I n-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)

3 - 12 Batgry InTounalien.
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Proper handling of the Battery Pack

* DO NOT disassemble the battery pack under any circumstances. ?ﬁl’:
» DO NOT expose the battery to fire or high temperatures, it may explode. Callion
* DO NOT connect the metal terminals (+, -) to each other.

AN
I

Damaged Battery Warning

Danger of explosion if
battery is incorrectly re-
o] el=To

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
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Battery FAQ

How do | completely dischargethe battery?

Use the computer with battery power until it shuts down due to alow battery. Don’t
turn of f the computer even if amessage indicates the battery iscritically low, just let

the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Hiii
T = s S ) el s i +|=
—— ik ey

Figure3-7
Power Plan Create & e
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Power Management

3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3-8
Change Plan
Settings / Change
Advanced Power
Settings
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4.
5.
Figure3-9
Power Options
Advanced Settings -
Battery

Scroll down to Battery and click + to expand the battery options.

Choose the options below (click Yes if a warning appears):
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Low battery levels= 0%
Critical battery Levels= 1%
Low battery action = Do Nothing
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Critical battery action (On battery) = Shut Down
Critical battery action (Plugged in) = Do Nothing
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configura-
tion, you should not enable SLI configuration if your computer is powered by battery
only. If you attempt to run an SLI configuration when the computer is powered by the bat-
tery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration.

If you have currently enabled SLI configuration, and the computer is powered by the AC/
DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and
disable SLI configuration before switching to battery power only).
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Drivers & Utilities

Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven't built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

RAID & AHCI Setup

Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID Mode” on page 7 - 2).

What to Install

The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table4 - 1, on page 4 - 3 listswhat you need to install
and it is very important that the drivers are in-
stalled in the order indicated.

Module Driver Installation

The procedures for installing drivers for the WLAN,
PC Camera, Consumer Infrared (for TV tuner re-
mote), Intel Turbo Memory, HDMI-In and Finger -
print modules are provided in “ Modules’ on page 7 -
1.

Mustang W650 Notebook
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Driver In Stal | at| on 1. Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in

Insert the Device Drivers & Utilities+ User’s Manual this order) which is the same as that listed in the

discand click I nstall Drivers (button), or Option Driv- Drivers Installer menu below.

ers (button) to access the Optional driver menu. 2. Click to select the driver you wish to install, (you

should note down the drivers as you install them).
- g 3. Follow the instructions for each individual driver
S installation procedure as listed on the following

B - - : =
ig,. S L Lobile L‘.;,q,-.__-=!,‘ h pages.

i

Y | =
p b U550 o

Figure4 - 1- Drivers Installer Screen 1

Figure4 - 2 - Drivers Installer Screen 2
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Windows 7 Driver Page Windows 7 Driver Page
. i Intel Turbo Memory & Matrix Storage Setup )
Chipset Page 4-6 and Driver Installation (for RAID) Page 7-8
Video Page 4 -6 Wireless LAN Module Page 7 - 18
LAN Page 4-6 PC Camera Module Page 7 - 36
Card Reader Page 4-6 TV Tuner Module Page 7 - 44
Intel Turbo & Matrix Storage Setup and
TouchPad Page 4-7 Driver Installation (for Turbo Memory) Page 7-56
USRB 3.0 Page 4-7 HDMI-In Module (for optional HDMI-In Page 7 - 51
Module)
Hot Key Page 4 -7 Fingerprint Reader Module Page 7 - 56
Audio Page 4 -7

Table 4 - 1 - Driver Installation
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Manual Driver Installation

Click the Browse CD/DVD button in the Drivers In-
staller application and browse to the executablefilein
the appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updates etc. (all updateswill includethe latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+" to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue thein-
stallation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

Mustang W650 Notebook
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
discand click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.

RAID Note: Setting up a RAID, or AHCI mode,
needs to be done prior to installing the Windows OS,
and therefore before installing the other drivers listed
here.

4 - 6 Drivey Installation .

Chipset

1. Click 1L.Install Chipset Driver > Yes.
2. Click Next > Yes> Next > Next.
3. Click Finish to restart the computer.

Video

1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

LAN

1. Click 3.Install LAN Driver > Yes.
2. Click Install.

3. Click Finish to complete the installation.

Card Reader

1. Click 4.Install Cardreader Driver > Yes.

2. Click Install > Finish.



TouchPad

1
2.
3.

4.

Click 5.Install Touchpad Driver > Yes.

Click Next.

Click the button to accept the license, and then
click Next.

Click Finish > Restart Now to restart the com-
puter.

USB 3.0

1
2.
3.

o A

Click 6.Install USB 3.0 Driver > Yes.

Click Next.

Click the button to accept the license and then
click Next.

Click Next > Install.

Click Finish.

Drivers & Utilities

Hot Key

1. Click 7.Install Hotkey AP > Yes.

2. Click Next > Next.

3. Click Finish > Finish to restart your compulter.

Audio

1. Click 8. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Mustang W650 Notebook
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4

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Click Windows Update (System and Security/
Security).

3. Click Check for updates (button).

4. The computer will now check for updates (you
need to be connected to the internet).

5. Click Install now (button) to begin checking for the
updates.

6. Click Install updates (button) to install the
updates.

Windows Experience Index

After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence I ndex (make sure the AC/DC adapter is plugged
in):

1. Click Sart, and click Control Pandl.

2. Click Performance I nformation and Tools
(System and Security > System > Check the
Windows Experience I ndex).

3. Click “Ratethis computer/Refresh Now/Re-
run the assessment”.

4. The computer will take afew minutes to assess
the system performance.

5. Closethe control panel.
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Optional Drivers

See the pages indicated for the driver installation pro-
ceduresfor any modulesincluded in your purchase op-
tion.

e i'i'lﬁ-mtu L'm_ -

vre Qi Vin Dol visi

Figure 4 - 3 - Optional Drivers Installer Screen

Drivers & Utilities

RAID Setup

Note: Prior to setting up the RAID you will need to use
an operable computer to copy the RAID driver to a
USB flash drive before installing the Windows operat-
ing system. See “ Setting Up SATA RAID Mode” on
page 7 - 2 for configuration instructions.

Bluetooth Module

Note: The operating system is the default setting for
Bluetooth control in Windows 7, and does not require
adriver. See “ Bluetooth Module” on page 7 - 12 for
configuration instructions.

Wireless LAN

See the appropriate install procedure for your WLAN
module in “Wireless LAN Module” on page 7 - 17.

PC Camera

Seetheinstall procedurein “PC Camera Module” on
page 7 - 35.

Mustang W650 Notebook
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Consumer Infrared (for TV Tuner Remote) HDMI-In Driver
See the install procedure in “TV Tuner Module” on  See the install procedure in “HDMI-In Module” on

page 7 - 43. page 7 - 51.

Turbo Memory Module Fingerprint Reader Module

See the install procedure in “Intel Turbo Memory See the install procedure in “Fingerprint Reader
Modul€e” on page 7 - 46. Module” on page 7 - 55.
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-

This chapter gives abrief introduction to the computer’s built-in software:

DlagnOSIICS The POS-I- (POWGI‘-OI’] %If T&) ed for guidance in set-
ting up your system’s
Configuration: The Setup utility BIOS.

If your computer has never been set up, or you are making important changes to the

; . . . BIOS versi b-
system (e.g. hard disk setup), then you should review this chapter first and notethe JEEE tovceg?;r;smaﬁ,;#ge

original settingsfound in Setup. Evenif you are abeginner, keep arecord of the set- B EER EVE R GE =
tings you find and any changes you make. This information could be useful if your VLS EhNEES ekl

screens may appear
slightly different from
those pictured on these
There is one general rule: Don’t make any changes unless you are sure of what you  BEEEES

aredoing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

system ever needs servicing.
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The Power-On Self Test (POST)

Z If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you

POST Screen turn on the computer the system takes a few seconds to conduct a POST, including
1.BIOS information aquick test of the on-board RAM (memory).

gﬁi%ﬁimus Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there

4.Enter Setup prompt | iSaproblem that preventsthe system from booting, it will display asystem summary

appears only during and prompt you to run Setup.
POST

Note: The POST screen | | there are no problems, the Setup prompt will disappear and the system will load

as pictured right is for | the operating system. Once that starts, you can’t get into Setup without rebooting.
guideline purposes only.

Phoenix SecureCore (tm) Desktop

The POST screen on Copyright 1985-2008 Phoenix Technologies Ltd.
All Rights Reserved

your ComPUter may ap- BIOS Revision: *kkkkkikk

pear S“ghtly different. If KBC/EC Firmware Revision: *kx%kk%x

the Boot-time Diagnos-

tic Screen iS disab|ed CPU = 1 Processors Detected, Cores per Processor = 4
Intel (R) Core(TM) i7 CPU, 960 @ 3.20GHz

(see page 5 - 9 as per the 2039 System RAM passed@

defau|t Setting) the POST 256 KB L2 Cache per Processor Core

. ' 8192K L3 Cache Detected
screen will not appear. System BIOS shadowed

Video BIOS shadowed
Mouse Initialized

Figure5-1
POST Screen

Press <F2> to enter SETUP e

5 - 2 The Power-On SeILTest (POST)
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

e Press<F1>toresume
e <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

Mustang W650 Notebook The Power-On Self Test (POST) 5 - 3
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.

The Setup Utility

The Phoenix Setup utility tellsthe system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(PressF2to Enter Setup) seenin Figure5- 1 onpage5 - 2 isusually present for a
few seconds after you turn on the system. If you get a “Keyboard Error”, (usually
because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
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Setup Screens
The following pages contain additional advice on portions of the Setup. Z

] ] ] Setup Menus
Along the top of the screen is a menu bar with menu headings. When you select a

heading, a new screen appears. Scroll through the features listed on each screento | The  Setup  menus

shown in this section are

make changes to Setup. for reference only. Your
computer's menus will
Instructions on how to navigate each screen are in the box along the bottom of the | indicate the configura- 5

screen. |If these tools are confusing, press F1 to call up a General Help screen, and “O“daf’pr%p”at_e for your
then use the arrow keys to scroll up or down the page. model and options.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow » next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

. |
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Main Menu
Pnoonmiw SsoureCors (tm)  Saisgp THed 144
Figure 5-2 I Main At n s Banaiel ty Book
Main Menu 51208 Item Specific Belp
Systen Date: [07£23/2010]
Oynten Mescry: £33 mn cTakse, CHRLPE Taks, ox
Extended Memory: 2038 MB SEnbars aalaaba Fisld
BIOS Revisioa: AN RS

KBEC fEC Firmware Revision| S

Ant VEA Caxce: nTINIA SeSEwETE
2nd VOA Card: OEVIODEK STeAsiEn
M= lp Sslect ITbem Thangs Valima Setup Defaults
Bl & Balect Manu Galeat Fiub-Harus fave and Beit

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will al'so change
these settings. Some applications may also alter data files to reflect these changes.
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System/Extended Memory: (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/VGA Card etc. (Main Menu)
This item contains information on the BIOS version and video card etc., and is not
user configurable.
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Advanced Menu

Fhoonix SecareZore {(tm)] St T ldity

Chmin [
FlgureS -3 Item Specific Help
Advanced Menu
B Rdvanasd Chipast Comtrol e At it
EXER
Lagecy USE Dupport: [Enablod]
Font-time Dimgrostio Boresn: [Ciipakiad]
Muast Configusebion Date: [Ma]
Pawar {n Bont Gesp [Dimasiad]
Oattory Low Alarm Deop: [Dipabliad)
Halp Exleck TEam Clhaszge Yaluma Satup Defaults
Exit Salect Mamm ‘Salect BSub-Hens fawe and Exit

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to enabl e/disable some advanced system features.
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SATA Mode Selection (Advanced Menu)
Y ou may enable/disable SATA RAID or AHCI modefor your hard disks, however ﬁ
you should only enable/disable SATA RAID or AHCI BEFORE installing an
operating system, and after you have backed up al necessary files and data (see

sidebar). See“ Setting Up SATA RAID Mode” on page 7 - 2 for details. If you have installed the
Windows 7 operating

SATA Mode

. system with either AHCI
Legacy USB Support: (Advanced Menu) or RAID mode enabled,

Choose “Enabled” if you intend to use USB devices in systems which do not nor-  BEsieR e e R
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and FullEmURTEERTERRER S

does not need to be changed if you intend to use your USB devicesin Windows. able the set mode you
will need to reinstall the

. . . Windows 7 OS).
Boot-time Diagnostic Screen: (Advanced Menu)

Use this menu item to enable/disable the Boot-time Diagnostic Screen. Enable this
item to display the POST screen (see “ The Power-On Self Test (POST)” on page 5
- 2).

Reset Configuration Data (Advanced Menu)

Thisitemis set to No as default. Y ou can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.
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5-10 Adv?nnced

ustang

Power On Boot Beep (Advanced Menu)
Use this menu item to enabl e/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Advanced Chipset Control Menu

Pl d 5 (o) Senop Ueilioy
-
kdvanced Chipssg Conzzocl Iten Epacific Help
1515 1 add]] [Dhaaiin]
Intal iH] Vietealliwatisn Teolng gy [Enallad] Aefauly pisalia Bo7
Hypu rEnramd Lo | [ Enalxlag]
Enatlad [Esimisle]
:m: % x: |rl b1 ..: Fivey Lagk Ehabos of BT
Figure5-4
Advanced Chipset
Control Menu
Halp Balact Tham Changs Valuas Batop Defaules
ENLL Balect Hesu Splect WEub-Mens Zave and ERLT

Bluetooth Power Setting > Advanced Chipset Control

Y ou can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

.|
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Intel Virtualization Technology > Advanced Chipset Control

Intel(R) Virtualization Technology enablesa CPU to act asif it were several CPUs
working in paralel in order to allow several operating systems to run at the same
time in the same machine.

Hyperthreading > Advanced Chipset Control

Hyperthreading activates additional CPU threads that may appear as additional pro-
cessors and is used to improve CPU multi-tasking. The operating system will view
a processor with Hyperthreading enabled as two virtual processors and will spread
any tasks between them (make sure your installed operating system supports multi-
ple processors, and preferably, is optimized for this technology). After enabling/dis-
abling Hyperthreading, and saving and exiting the BIOS, the system will shut down
(press the power button to turn the system on again).

CPU C Sate > Advanced Chipset Control
Enable/Disable CPU C States (operating states) here.

Turbo Boost > Advanced Chipset Control

Y ou can enable Turbo Boost to automatically run the processor core faster than the
stated frequency (within specification limits of the Thermal Design Power) for in-
creased performance.

5-12 Adv%ncedvggpoiﬁge%gockiontrol Menu
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Security Menu =
Fhoenis Secsireore | tm) Lo =hET )
Secusity Security Menu
. TEen Spacific Ralp The changes you
T e T A i trars make here affect the
Zuparvisoc FEEmwarcd
fertarl] cahbrols soche b5 Lhe a(?(?ess. o 2 SE
Sut Omss Fazssccd T | satop ukility. utility itself, and also
: s i g access to your ma-
PRI e e chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network  passwords
which will be set in
your software OS.
Eelp Selmct Item Change Values Eetup Defaalts
Exit Select Manu Aelackt W Sub-HEns Bave and Exit FigureS -5

Security Menu

Set Supervisor Password (Security Menu)

Y ou can set a password for access to the Phoenix SecureCore Setup Utility. This
will not affect access to the computer OS (only the Phoenix SecureCore Setup
Utility).
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SN
L&

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled®), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

Set User Password (Security Menu)

You can set a password for user mode access to the Phoenix SecureCore Setup
Utility. Thiswill not affect accessto the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu itemsin the Phoenix
SecureCor e Setup Utility cannot be modified in user mode. Y ou can only set the
user password after you have set the supervisor password.

Password on boot (Security Menu)

Specify whether or not apassword should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“ Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.
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Boot Menu
Adw ainced = lﬁ?b Flgure 5 - 6
Ttam Spscific Halp Boot Menu
Bask prigTity acdss:
B BUT ACEE: PRE-TOGHERR MEXTECOEN PRt o R T
31 UEN EEY: aanflguers davioad!
&= En EDO: Up ard Down azposn =
5: FLI BEV: JMCISK Sigubit EEhecnet Co selact & devica. ﬂ:
:: bR and e moves
Bz K Favlon, wp SF. on.. BIOS Screens
Exmiudsd frem bosk ardar anr wielods s Lneluds
1 UME CO®OM: - +.
| e e i gt T i Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.
Halp Balect Itasm Changs Valods Eetup Dafaults .
Emik Baluct Mano Select B Ouk-bemo Sove amod Exib BIOS versions are sub-

o . ject to constant change
When you turn the computer on it will look for an operating system (e.g. Windows B =EE S el il el

7) from the devices listed in this menu, and in this priority order. If it cannot find  FCEIE el IR diEy
the operating system on that device, it will try to load it from the next deviceinthe J s el i

e L. .. - . . . slightly different from
order specified in the Boot priority order. Item specific help on the right is avail-  FEES pictured on these

able to help you move devices up and down the order. pages.
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Figure5-7
Exit Menu

5-16 ExitMenu

Exit Menu
Exit
Ites Speclfic Halp

Exit Dlacerding Chamgas Exit Systam Smbop and
Load Setup Dafaults anwE your changss ko
Piscard Changes CHOEB
Sava Chamges

Relp Select Ttam Change Values Setup Detfanits

Exit Select Manu Ealsot FSub-Memu Save and Emit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. Y ou can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.
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Upgrading The Computer

Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problemsyou can con-
tact your service representative for further help. Before you begin you will need:

» A small crosshead or Phillips screwdriver
* A small regular slotted (flathead) screwdriver
e Anantistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive(s)

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make surethat you review each procedure beforeyou perform it.

SN
A&

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Mustang W650 Notebook

Overview 6 - 1



Upgrading The Computer

SN
L&

Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines).

It is advisable to also re-
move your battery in or-
der to prevent
accidentally turning the
machine on. Before re-
moving the battery
disconnect the AC/DC
adapter from the com-
puter first.

6 -2 Overvhjlew

When Not to Upgrade

These procedures involve opening the system’ s case, adding and sometimes replac-
ing parts.Y ou should not perform any of these upgrades if:

* Your system is still under warranty or a service contract
* Youdon't have al the necessary equipment

* You'renot in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

S
Z s

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with afast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

ustang W650 Notebook



Upgrading The Computer

Removing the Battery .

If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery. Befor e removing the battery disconnect the AC/

DC adapter from the computer first. Please check with your
service representative

SN
L&

Warranty Warning

1. Turn the computer off, remove the AC/DC adapter and turn it over. )
before undertaking any

2. Loosen screws @ - @ and carefully lift the battery @ up. p p :
3. Remove the battery from the battery bay. ;Egrgute ifptL?gewiLIlln\a/%IIcD)

your warranty.

Figure6-1
Battery Removal

Mustang W650 Notebook Removing the Battery 6 - 3



Upgrading The Computer

Upgrading the Hard Disk Drive(s)

\ A/

’Ll‘ The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA)
HDD System Warning hard disk drives with a height of 9.5mm (h) (see “ Storage” on page C - 2). Follow
NE i bnre sl your operating system’s installation instructions, and install all necessary drivers
fore you begin make sure: and utilities (as outlined in “ Drivers & Utilities” on page 4 - 1), when setting up a

You have backed up any .
data you want to keep from new hard disk.

your old HDD.

You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

6 -4 Upgr%in mgoldardoleisk Drive(s)

stal otebo



Upgrading The Computer

Removing the Hard Disk(s) from the Primary HDD Bay

1. Turn the computer off, remove the AC/DC adapter, turn it over and remove the bat- ﬁ
tery. .
2. Locate the hard disk bay cover and remove screws @ & @. AR CTEHRIELS
3. Remove the hard disk bay cover @. All hard disks in a RAID

should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

Figure6- 2
Primary HDD Bay
Cover Screws &
Cover Removal
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Upgrading The Computer

Disconnect the HDD cable @.

Remove screws @ - @ from the hard disk assembly.

Pull the tab @ to disconnect the hard disk assembly from the connector.
Remove the hard disk assembly @9.

Remove the HDD board & cable @.

O N aA

Figure6- 3
Hard Disk Assembly
Screws & Removal

6 -6 Upgr%in EVQEON(?}EQ,OP‘Sk Drive(s)
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Upgrading The Computer

9. Remove screws @ - @ (depending on how many hard disks you have installed in
the assembly).
10. Remove the hard disk(s) @ from the case.

Figure6- 4
Hard Disk(s)
Removal

Upgrading the Hard Disk Drive(s) 6 - 7
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Upgrading The Computer

11. If two hard disks are installed then an insulation plate will be installed on the upper
hard disk.

12. Remove screws @@ - @ and the insulation plate &b.

13. Reverse the process to install any new disk(s) and do not forget to install the
insulation plate (onto the upper hard disk in the orientation illustrated below),
screws, cables and covers (pay careful attention to the orientation of the hard disks
in the case).

Figure6-5
Upper HDD
Insulation Plate
Removal

6 -8 Upgr%in mgoldggl)dc)olgisk Drive(s)
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Upgrading The Computer

Inserting the Primary Hard Disk(s)

1. Insert the HDD(s) @ into the case as illustrated (make sure the cable connec-
tors are facing towards the gap at the rear of the case, and that the upper HDD
insulation plate is installed).

2. Insert screws @ - @ to secure the hard disk(s) in the case.

Figure6- 6
HDD Insertion &
Screws

Upgrading the Hard Disk Drive(s) 6 - 9
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Upgrading The Computer

Figure6-7
HDD Cable Insertion
& Bay Screws/Cable

Connection

Firmly insert the HDD cable @ into the hard disk case @ as indicated below.
Insert the HDD assembly into the bay by pushing it straight down (do not insert the
assembly at an angle).

Firmly connect cable @ and then secure the assembly with screws @) - @.

6 - 10 UpgmgtgpgqN%Igc)eNI;g)Engisk Drive(s)



Upgrading The Computer

Removing the Hard Disk from the Secondary HDD Bay

1. Remove the battery (the Secondary hard disk bay is located under the battery).
2. Remove screws @ - @ from the hard disk assembly.

3. Grip the tab and slide the hard disk assembly in the direction of the arrow @.
4. Lift the hard disk assembly out of the compartment.

Figure6- 8
Secondary HDD
Assembly Removal

Mustang W650 Notebook Upgrading the Hard Disk Drive(s) 6 - 11
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Figure6-9
Secondary HDD
Assembly Removal

oo

&

Remove screws @ - @ from the hard disk assembly.

Separate the HDD @ from the case @.

Insert the replacement HDD into the case (make sure the cable connector is
facing towards the rear of the case as illustrated below).

Replace screws @ - ©.

Insert the HDD assembly into the bay by pushing it straight down (do not insert the
assembly at an angle) and then slide it in the direction of arrow @ to lock in place.

6 - 12 Upgmgt;pgqN%IgOeNIg!g)%ngisk Drive(s)



Upgrading The Computer

Upgrading the Optical (CD/DVD) Device

1.

N

Locate the hard disk bay cover and remove screws @ & @.

Remove the hard disk bay cover @.

Remove the screw at point e and use a screwdriver to carefully push out the
optical device at point @.

Reverse the process to install any new optical device.

Figure6 - 10
Removing the CD/
DVD Device

Mustang W650 Notebook Upgrading the Optical (CD/DVD) Device 6 - 13




Upgrading The Computer
Upgrading the System Memory (RAM)

The computer has three memory sockets for 204 pin Small Outline Dua In-line
(SO-DIMM) DDR |11 (DDR3) type memory modules (see “ Memory” on page C -
2). The total memory size is automatically detected by the POST routine once you
turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws @ & @ from the bottom of the computer

Figure6- 11
LED Module Screws
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Upgrading The Computer

3. Turn the computer over, open the Lid/LCD, and carefully (a cable is connected to
the underside of the LED cover module) unsnap up the LED cover module from
point @ on the right.

Figure6 - 12
LED Cover Module
Removal

4. Disconnect cable @ and remove the LED cover module @.

Figure6- 13
LED Cover Module
Cable Disconnect

Upgrading the System Memory (RAM) 6 - 15
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5. Remove screws @ - @ from the keyboard.

Figure6 - 14

Keyboard Screws

6. Carefully lift the keyboard up, being careful not to bend the keyboard ribbon cable.
7. Disconnect the keyboard ribbon cable €& from the locking collar socket @.

Figure6 - 15
Disconnect the
Keyboard Locking
Collar
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8. Remove the keyboard @®.

Upgrading The Computer

9. Remove screws (@ - @ from the keyboard shielding plate.

= s

Figure6 - 16

Keyboard Removal

Figure6 - 17
Keyboard Shielding
Plate Screws

Mustang W650 Notebook
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Upgrading The Computer

10. Lift the keyboard shielding plate up in the direction of the arrow €.
11. Remove the keyboard shielding plate @®.

Figure6 - 18
Keyboard Shielding
Plate Up

Figure6- 19
Keyboard Shielding
Plate Remove
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Upgrading The Computer

12. Gently pull the two release latches (@ & @) on the sides of the memory
socket(s) in the direction indicated below.
13. The RAM module @ will pop-up, and you can remove it. Figure6 - 20
RAM Module
Removal

SN
L&

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s

14. Pull the latches to release the second module if necessary.

erformance.
15. Insert a new module holding it at about a 30° angle and fit the connectors firmly -
into the memory socket. LED Module Cable
16. The module’s pin alignment will allow it to only fit one way. Make sure the module

is seated as far into the socket as it will go. DO NOT FORCE the module; it should ikl G SN BT Ll
o nect the keyboard cable
fit without much pressure. @ ). and
17. !Dress the module in and down towards the mainboard until the socket levers click LD s el el
into place to secure the module. 4 (see ).
18. Replace the shielding plate (see over) screws, keyboard (reconnect the keyboard

cable) and LED cover module (see the preceding pages).

Mustang W650 Notebook Upgrading the System Memory (RAM) 6 - 19



Upgrading The Computer

Keyboard Shielding Plate | nsertion

1. When re-inserting the keyboard shielding plate @ make sure you insert it by slid-
ing it into position at an angle as illustrated by arrow @ below, and press it down
into position.

2. Secure the plate with screws @ - @.

Figure6 - 21
Keyboard Shielding
Plate Insertion
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Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

» Setting Up SATA RAID Mode
Bluetooth Module

Wireless LAN Module

PC Camera Module

TV Tuner Module

Intel Turbo Memory Module
HDMI-In Module

* Fingerprint Reader Module
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RAID Hard Disks

All hard disks in a RAID
should be identical (the

same size and brand) in
order to prevent unex-
pected system behavior.

Setting Up SATA RAID Mode

AHCI Mode

Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one, two or three hard disks.

RAID

To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes (see
Table 7 - 1, on page 7 - 3) you will require at least two identical (see sidebar) hard
disks; to configure your system in Intel® Rapid Recover Technology (Recovery)
mode you will require two hard disks installed; to configure your system in Parity
Across Disks (RAID 5) mode you will require three hard disksinstalled.

Intel® Matrix Storage Manager

Make sure you install the Intel Matrix driver and application if you have set up your
hard disk(s) inRAID mode (see” I ntel Turbo Memory & Matrix Storage Setup and
Driver Installation” on page 7 - 8).
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RAID Level Description Table7-1
Identical drives reading and writing data in parallel to increase performance. RAID 0 RAID Levels
RAID 0 implements a striped disk array and the data is broken into blocks and each block is

written to a separate disk drive.

4

Identical drives in a mirrored configuration used to protect data. Should a drive that is

RAID 1 part of a mirrored array fail, the mirrored drive (which contains identical data) will Array Types
handle all the data. When a new replacement drive is installed, data to the new drive is
rebuilt from the mirrored drive to restore fault tolerance. A Mirrored Array

(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
Two Identical drives copying data between a master and a recovery disk. This provides disk to a replacement
Recovery more control over how data is copied between the master and recovery drives, fast for any failed disk.

volume updates and the ability to view the data in Windows Explorer.

Identical drives (at least three drives must be used) in a parity across disks
RAID 5 configuration are used to protect data and increase performance. A RAID 5 array
can withstand a single disk failure without losing access to data.

A  Striped Array

Prepare the following before setting up your serial ATA hard disksin RAID mode: || (RAID 0) is NOT fault-
tolerant. The failure of

1. The Microsoft Windows 7 OS DVD. one drive will result in
2. Asecond (identical) hard disk installed in the Primary HDD bay. the loss of all data in
OR the array. It is de-
A second (identical) hard disk installed in the Primary HDD bay, and a third signed to increase disk
(identical) hard disk in the Secondary HDD bay if required. performance by
3. The Device Drivers & Utilities + User’s Manual disc. spreading the I/O load
across the channels

and drives.
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SATA RAID Setup Procedure (BIOS)

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Gotothe Advanced menu, select "SATA Mode Selection” and press Enter (see
page 5 - 8).

Select “RAID”.

3. Press Esc and go to the Boot menu.

4. Set the DVD-ROM Drive (make sure the Microsoft Windows 7 OS DVD is
inserted) as the first device in the boot order from the Boot menu (see “Boot
Menu” on page 5 - 15).

5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and
press Enter to exit the BIOS and reboot the computer.

6. See the instructions in “RAID Setup (Intel Matrix)” on page 7 - 5.

7 -4 Setti%sg%éég'@)tRALD Mode
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RAID Setup (Intel Matrix)
1. As the computer starts up press Ctrl + i to enter RAID configuration menu.

Lrcal (B Pagld Seasegs ] O pica Faimi ¥ E.0.1054
Copy=ight £ 2001 craticom. ALl Rights Bmassred

| Crasts FATD YVolias

o Dolete FAID Yolouse

EHTER] - Galwct

2. Select 1.Create RAID Volume and press Enter.

3. Type the RAID volume name and then press Tab or Enter to advance to the next
field.

4. Specify (use the up and down arrow keys) the RAID level (RAID 0, RAID 1, RAID
5 or Recovery - see Table 7 - 1, on page 7 - 3) and then press Tab or Enter to
advance to the next field.

Modules

Figure7-1
Intel(R) Rapid
Storage Technology
Option ROM

4

Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization  between
the disks to be Continu-
ous (automatic) or On
Request (manually).
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4

Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization  between
the disks to be Continu-
ous (automatic) or On
Request (manually).

Figure7-2
RAID Created

Press Enter and the system will select the physical disks to use.

Press Enter and select (if applicable) the Strip Size (best set to default).
Press Enter and select the Capacity size (best set to default).

Press Enter to select Create Volume.

Press Enter to create the volume, and confirm the selection by pressing Y.
10 This will now return to the main menu.

© 0N,

Inksl (Al Fxpid Stocags Techoology Opbion T H.8.0.1014
Copyright (£] 23097-10 [nbel Carmaratiss, AL Rights Rosenssd

[
i Ceantm BRID Voloms 3 Hagnmi adkn BEx Hon=-RAID

= Cndlmts EATD Wolyses L Racovery Volums pbians

[ENE] -Exlt

11. Select 5.Exit and press Enter, then press Y to exit the RAID configuration menu.
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12. Make sure the Windows 7 OS DVD is in the DVD drive. and as the computer
starts up it will automatically boot from the Windows 7 OS DVD.

13. Press Enter to continue installing the operating system as normal (see your
Windows documentation if you need help on installing the Windows OS).

14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Matrix driver
- see “Intel Turbo Memory & Matrix Storage Setup and Driver Installation” on
page 7 - 8).

ustang V650 Notebook Setting Up SATA RAID Mode 7 - 7



Modules

Intel Turbo Memory & Matrix Storage Setup and Driver Installation

1. Insert the Device Drivers & Utilities+ User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 4.Install TM&iMSM Driver > Yes.

Click Next > Next > Yes > Next.

Click Finish to restart the computer.

arowN

The Intel Matrix Storage Console displays status information on your RAID con-
figuration. Run the Intel® Matrix Storage Console from the Intel® Matrix Stor-
age Manager in the Programs/All Programs menu. The Intel® Matrix Storage

Manager providesinformation on the RAID status.
Figure7-3 mrn | et et -
Intel Matrix Storage T
Console £ ;
(Basic & Advanced ; :_1
Views) o

e e
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Intel® Matrix Storage Manager

If ahard drive member of aRAID volumeis reported as“Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the datafrom aback up. TheHelp
menu (press F1 or select Contents and Index from the Help menu) provides in-
structions on how to recover or recreate RAID Volumes.

e e BUFH T ' F 7 4
g o - igure7 -
=B B P AL o L - E - e e e H
| - — . . Intel Matrix Storage
FMEL Wi TRIN IMRACL MINLCER TP Imecl® Natrix Storage Console Cherviow
----- Manager Help
St et Tl bl Ao e e b S e T e rerrm e e el Gl o € L e L s oy e
e i e =] e Ca ol e kil L Bk o] ol vl i a4 T8 A0l B e e e
meiomn n syl w o otrms e e m idd U fesse]’ presess medE G Dl @Al 0 Seesl o vene el i o ome of e e
- B b e P et N il S O D OO e i e I T el b
| bl
B v ok o 1 rered e b, B lende, S chemod M o i Lt o s - B et s
rresmr pr b e e e e S pres s bl e b e e e e e
i e ke ko m S 1 i e el B et ok e T e
bk i iade:
_— i b ol e e o me it sy B B W Y N e Vs apb ey U e el e e B
e b e e B o e AT b o el s e ] &
2 Tk b e e Ml e i Bl e b Lir s e b i
L e by ol ] B B e e ey =i e oy W E e e Bane B -
s i = b e meem el e e e PR D e e mm b o B3] e A
E s ol e herd e =Bl
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'
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RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad
dataon aRAID 0 or RAID 1 volume. The table outlines what occursfor each RAID

Verify

Verify & Repair

Bad blocks are identified.

N/A

Bad blocks are identified.

Data on the mirrored drive is compared to
data on the source drive.

Bad blocks are reassigned.

If the data on the mirrored drive does not
match the data on the source drive, the
data on the mirrored drive is overwritten by
the data on the source.

level:
RAID
Level
RAID 0
RAID Verification &
Repair Status
RAID 5

Bad blocks are identified.

Parity is recalculated and compared to the
stored parity for that stripe.

Bad blocks are reassigned.

If the newly calculated parity does not
match the stored parity, the stored parity is
overwritten with the newly calculated parity.

Replacing and Reverting Recovery and Master Volumes

If amaster or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. Y ou can also revert the master drive to the
state of the previous volume update. For details on how to do this see” Intel Matrix
Storage Manager Help” on page 7 - 9.

See over for details on how to verify and repair RAID volume data.
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Verifying and Repairing RAID Volume Data

1. Runthe Intel® Matrix Storage Console from the Intel® Matrix Storage Man-
ager in the Programs/All Programs menu.

2. Click View > Advanced Mode.

3. Right-click on the RAID volume and select either Verify Volume Data or Verify
and Repair Volume Data.

Figure7-5
RAID Verification
(Intel® Matrix
Storage Console)

4. The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair
status.
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Wireless Device
Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED to see if the
module is powered on or
not (see

/

)

Bluetooth Module

The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, print-
ers, digital cameras, PDAS, headsets etc. using a short-range radio frequency.

Usethe Fn + F12 key combination or Touch Sensor Instant K ey to toggle power
to the Bluetooth module. When the Bluetooth module is powered on, the touch sen-
sor LED will be highlighted and the indicator ﬁ will briefly be displayed.
The operating system’s Bluetooth Devices control panel is used to configure the
Bluetooth settings in Windows, and therefore does not require adriver.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use
the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from
Sleep.
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Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it 4

1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. Add a Device

2. Make the device discoverable (to do this check your device documentation).
Click Start, and click

To Turn the Bluetooth Module On Control Panel and then
1. Pressthe Fn + F12 key combination to power on the Bluetooth module. clu_:k Devices and
2. A Bluetooth icon [ will appear in the taskbar. Printers ~ (Hardware

3. You can then do any of the following to access the Bluetooth Devices control and Sound). Click Add
panel. a device to search for

any available Bluetooth
+  Double-click the taskbar icon [J to access the Bluetooth Devices control panel. devices.

« Click/Right-click the taskbar icon [ and choose an option from the menu. ) )
If you are experiencing

S o B 4 Desice problems connecting to

-1 d w1 et some Bluetooth devices
» Shaw Nlua btk Darviean see “” on page 8 - 14.
Sl o Fiie
Aererse aFils

fam o Perionsd Ares Metweerk

Dy Sattingn Bluetooth Devices &
Click Icon Menu

Add a device Resire Lo

s e i
Right-Click Taskbar Icon [J
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To Add a Bluetooth Device

/ 1 1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

Pairing Options

b |
If a device has been pre- Lol e v

viously connected then g
the pairing option menu tardect W devire oy aeirl bo the pompenen

Wl" appear When yOU at- Widnen «d N coyes b Wk ves dmwmand #ipley e bpa
tempt subsequent con-
nections. You can choose A P My .
to have the computer cre- B | i
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure7-7 .
Add a Device

3. Onfirst connection the computer will provide you with a pairing code to be entered
onto the device.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

; I-I..- l. . . a /

» Figure7-8
- e Pairing Codes Pairing Code
BEALIHA) The example outlined here shows a connection to Example
b 4 . = 0 a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
ny Pekevarer et e code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
5. Windows will check to see if any drivers are required to complete the pairing.
6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.
7. Click Close.
— - T =
I T TSR T B i = Figure7_9
l - : . | . Pairing Complete &
= b Bluetooth Device
Enabled
. ‘.:I
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‘ To Change Settings for the Bluetooth Device
/ + 1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

* Change the name of the device (click Bluetooth, type a new name and click OK).
« Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth

configuration - and ~ set- | Tq \Make your Computer Discoverable to Bluetooth Devices
tings, select Help and

Support from the Start 1. Cl!ck the 'Faskbar icon and select Open Settings. _ _ _
menu. Type Bluetooth in 2. Click Options, and make sure that Allow Bluetooth devices to find this

the Search Help box, and computer check box (Discovery) has a tick inside it.
select an item from the re- 3. Make sure that the Alert me when a new Bluetooth device wants to connect
turned search results to check box (Connections) has a tick inside it, if you want to be notified when a
get more information. Bluetooth device wants to connect.
'n._..-...,. — hp@
e
i ol e e i
Figure7-10 e ——
Bluetooth Settings - || #emenonnme e g i
Options T B p—
L =5 it
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Wireless LAN Module

If you have included an Intel® Advanced N Wi-Fi Link 6200, Intel® Ultimate N
Wi-Fi Link 6300 module or 3rd Party 802.11b/g/n WL AN module in your pur-
chase option, make sure that the Wireless LAN module is on before installing the
driver.

Usethe Fn + F11 key combination or Touch Sensor Instant Key to toggle power
to the Wireless LAN module. When the WLAN moduleis powered on, the touch sen-
sor LED will be highlighted and the indicator m will briefly be displayed.
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
The operating system is the default setting for Wireless LAN control in Windows 7.

Wireless should be turned ON in the Windows M obility Center to ensure proper
wireless function key behavior (see“ Wireless Hot Keys’ on page 7 - 34).

Wireless Device
Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure

the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination/Touch Sensor In-
stant key to toggle power to
the WLAN module, and
check the LED to see if the
module is powered on or
not (see
/

).
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Intel® Wi-Fi Link Series Driver Installation

4 If you see the message “Found New Hardwar e’ click Cancel to close the window.
Intel(R) PROSet/ 1. Make sure the moduleis powered on, then insert the Device Drivers & Util-
el ities + User’'s Manual disc into the CD/DVD drive.

Access the Intel PRO- | 2. Click Option Drivers (button).

Set Wireless tools (Sta- | 3. Click 1.Install WLAN Driver > Yes.

tistics and Diagnostic 4. Click Next > Next.

tools) from the Start § 5 cjjck the button to accept the license and click Next.
6

menu (Start > Pro- . -
grams,A(" Programs > Click Next > Next > Finish.

:nte' PROSet Wire- | Note: The operating system is the default setting for Wireless LAN control in Win-
ess). These tools pro-

vide diagnostic and | dows (seeoverleaf).

statistical  information . .
only (use the wiLAN | 802.11b/g/n Driver Installation

control in Windows to | 1, Make surethe moduleis powered on, then insert the Device Drivers & Util-
gggge‘;;‘t’) a WLAN ac- ities + User’s Manual disc into the CD/DVD drive,
PO Click Option Drivers (button).
Click 1.Install WLAN Driver > Yes.
Choose the language you prefer and click Next.
Click Next > Install.
Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows 7 (see overleaf).

OOk wWN
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Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon [, and then double-click an access point to con-
nect to or click to Open Network and Sharing Center if you do not see a network

you want to connect to in the taskbar menu (a list of options will appear allowing
setting changes, and creating a new network).

Ko rome s

ﬂﬂ O T I e e B

S hRLLEPLE,

Modules

4

Network and
Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure7-11
Click Taskbar Icon
Menu & Network
and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying
to connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

- i | ey Lesu by
Figure7- 12 Thes netywark lncalion (s s Work
Network Location --l-' L
feraann wps Wk
Set L " -, il G (T [eeds
L i T ]
L
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5. Click the taskbar icon g to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon

., click the active connection and then click Disconnect (button). Security Enabled
Networks

Li |1I1'I:| O R R
Wil o

You should try to make
by e el bl

sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

ofll =

Figure7-13
Click Taskbar Icon
Menu - Disconnect

ThpeFaariws 5 F#owi i pris
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Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel PRO-
Set Wireless > Intel My
WiFi Technology), or by
clicking the taskbar icon
. Click the Help icon
and select a
help topic from the Con-
tents menu.

7 - 22 Wirehl/lgsstasng%%

Intel® My WiFi Configuration

Intel® My WiFi Technology uses your WLAN (for Intel WLAN modules only)
module to allow you to connect up to eight other WiFi enabled devices (e.g. digital
cameras, other computers, cell phones, handheld devices etc.) to your computer
(similar to Bluetooth), while still connecting to the Internet through your WiFi wire-
less connection. Intel® My WiFi Technology offers greater range and speed than
other personal area networks, and does not require an access point.

Mod%ue

Notebo
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Intel® My WiFi Configuration
Y ou can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon

2. Click Enable @ =@ (on the first run of the program there will be no connected
devices listed).

e rrris = 8 kb WA Ty Tl

Intel™ My WIF Tachnoiogy

Erahiod Waass gl

e T ety o M=ot R Figure 7-14

e e e . Intel® My WiFi
o oy e ey, e 4 B WY By e G . Utlllty

By e ey iy v bl
T cam et o e rievion b bhin com ke dick Ao Bew De i,

ot moy v v

0 eIy CRRneCte Sevices 1 ey
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3. Click Start and click Control Panel.
4. Click Network and Sharing Center (Network and Internet).
5. Click Change adapter settings.

Figure7 - 15
Network and
Sharing Center
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Modules

6. Right-click Wireless Network Connection and select Properties.

Digureae = Civsan e 1e rartvaz ik teacs Asname sz comastion. b T . FIgUI’e 7 _ 16

Q Local Area Connachan % Phratuns Mitwork Caremclion Network

Hrtwork cocle unpluage:d 3 Fok rormoched i
8 A alon PO B Sipati e W il WriR] E pin oo U b Connections

- sl Mrtwork Conosctien
Her comnexieil W Dbl Right-click Wireless Network
Falia Connection and select Proper-

ties.

x .:Iﬂ_ Ut Wil WAF:

Cresle Shrtou

i pler

Progariies
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7. Click Sharing (tab) and select “Allow other network users to connect through
this computer’s Internet connection”.

8. Select Wireless Network Connection under Home networking connection.
9. Click OK.
[ & Wiretess Network Connection B Properties =)
- : e ! -
) | petscdang | Frsng
Click “Allow other network
users to connect through et Larrsofen Shimng
this computer’'s Internet 7 Ml e rstci L o corect throu h ths
connection”. g e o i
Haee netvorking conneciion;
_ Select Wireless Network %ﬂ&:ﬂhﬁ'ﬂﬂ" Zi
Figure7 - 17 Connection. I | 2 ol e et
i W
Wireless Ngtwork I TP P
Connection i T o L T
Properties -
Sharing
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10. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon

11. Click Profiles gzt =,

Sk AW b T e

et My WIF Technoiogy

§ mabfnd [ ESTTIN ™ B
o i b oy ey e o e e ot et |
Pl [OH WTGES RS FAF i Bl IR TR @
A Figure7- 18
i D 11 : Intel® My WiFi
Tt caseert @ e devion b this compuber. ek Aol Bew Device. Utility - Profiles
Ry moy L et Gorers - ]

b previendy cxerrcied Sonces T ey
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12. Click Profiles, click Intel Wireless PAN and click Edit or New (Note that all

Figure7 - 19 preset settings may nci be editable - see sidebar).
Profiles — : e

| ]
T rmrrm s E———
T EEE g -
Hem i -

et i |

4
Profile Settings @@m

Profiles that are preset | 1
may not be fully edit- 13. You can change the Profile Name and Network Name to your personal
able. To edit all the preferences in General (tab).

profile settings, click
4 . 1 Peodile Settings e !

New to create a new
profile and adjust the
settings to your prefer- IR T
ences.

Profile and Network Names

]

The Profile Name is the name as dis- T 1
played on your computer in the Net-
work Connections control panel e
Figure7- 20 (see Figure 7 - 21 on page 7 - 29).
Intel® My WiFi _ A Py Py 2 R T NPV TE RS BT TR
Profile Settings - The Network Name (SSID) is the A L L Y T
General name the devices see when they try
to connect to your computer.
-
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14. Click Security (tab).

15. Change the Security Type to WEP and the Encryption Type to 64bit.
16. Enter a password (8 characters long) in the Password box.

| Profie Settings ren

[ eonerm| 520ty | Shavg | Advarced

R —
e e BB m—

R Figure7-21
Intel® My WiFi
vareiens Secuty Fasevond [Encrypon Ry Profile Settings -

Security

Cwra-ma rxi1ow B Seourity P areord eriere o atere s i coonec! o e Drviel O
Wy W A comnm Poin

I T
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17. Click Sharing (tab).
18. lti

It is recommended that the Filter Network Traffic and DHCP and DNS Server
are Disabled.

Profile Settings

| [l [ seanty | S0 | Adverced |
[

Tk Connscion Shiving snd Bridgn [ Fte

Thia saking pravsants cevon carrciec io the ekl Mp S N vork I:I'TH-I':C—'I'!
e racha srea i cugh inbomat orrecion shaeng or netweart brcging

nhrmm-n-aﬁtc =|
Figure 7 - 2_2

Intel® My WiFi DHCF mnd DHE Sereens
; R _ Ui enabiod, S Inbald by B R wdl Ren TP addneenas ard resalva derioa
PrOfIIe Se_ttlngs e Tod connaciod deabnonl CRiahie T other DD P 2 DHS wdrvirs 2id svalahls on
Sharing s e

DHCP e DHE Seveers -

o'l DHCP and DHE garvees ana auloma il thabicd whear T i bhork & sharad
v cigh i oset Corwecior lring
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19. Click Advanced (tab).
20. Itis recommended that the Default Channel is set to Channel 1, 6 or 11.
21. Click OK to save the settings.

‘ii Profile Settings e !

| |Barral | secaey [ shamg | #evce:

D Pttt Chuasrmrwd

Thee charmed of the Dol My WA hiest ook will submedicellp e b e sssocted acrso
pcke, I e acdaier i et aeemisd 1060 e ok, the Tilieng settings are sed for

riet B oy B4R Teachnodogy:
e Figure 7 - 23
| Intel® My WiFi
Profile Settings -
— Advanced

Mustang W650 Notebook Wireless LAN Module 7 - 31



Modules

Figure7-24
Wireless Network
Connection Details

22. Double-click Wireless Network Connection in Network Connections.
23. Click Details to display the Network Connection Details.
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Modules

24. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
the taskbar icon

25. To add a new device follow the instructions in the devices’ user guide for
connecting to a WiFi network.

26. Click Add New Device in Intel® My WiFi Utility to confirm the security settings
detail.

Inged® My = Technology

¢ T S

Barigdp izemiqurs @ thrrew

Rty A e e e o e
sy e o e e Pl pevash el i
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hm_,“' L T PR Sy sy
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Y [ | W— 1
= Linwyprin g ald
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Figure7- 25
Intel® My WiFi
Utility
(Add New Device)
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
Wireless Hot Keys information on battery status, power plans used and wireless device status etc.

W SRSl To access the Windows Mobility Center:
function keys will not func-

tion properly if Wireless is 1. Click Start, and click Control Panel (or point to Settings and click Control

turned OFF in the Win- Panel).

dows Mobility ~Center 2. Double-click Windows Mobility Center (Mobile PC).

BRIl [FEEL 3. Click the button to Turn wireless off/on, or click the icon . to access the network
menu.

The wireless indicators
ESE# may show that
the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on.

bnghiresys ll"_‘-‘- [ehite l 5% remuainmg

] — = | My CustoenPanl v
Make sure that Wireless is
ON in the Mobility Center to Erghtnes Nohamne Hpttery Stakee
ensure proper function key
behavior. Py i3 M e E- e
rormected prrinershigs WP totpreetig
Figure7 - 26 u- FOMD [ O
Windows Mobility Bresentakion Setting:

Center -
Make sure Wireless is ( 0 ensure proper
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PC Camera Module

Before installing the driver, make sure the PC Cameraison. Usethe Fn + F10 key
combination or Touch Sensor Instant K ey to toggle power to the to the PC Camera
module. When the PC Camera module is powered on, the touch sensor LED will be
highlighted and the indicator ﬂ will briefly be displayed. Make sure you install
the driversin the order indicated in Table 4 - 1, on page 4 - 3.

There are anumber of different cameramodul es avail able with this computer model
series. You will have the appropriate application installed for your camera (note that
some versions of the camera application do not support the zoom function). M ake
sure you access the application via the desktop shortcut.

2NZ
2L &

PC Camera Application and Power-Saving States

If the computer enters Sleep or Hibernate mode while running the camera application, the
program will stop running, and will need to be restarted when the system resumes from the
power-saving state.

Latest PC Camera
Driver Information

Check the Device Drivers
& Utilities + User’s Manu-
al disc and any accompa-
nying insert pages, for the
latest updated information
on the PC Camera driver,
which may override the in-
formation provided here.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).
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7 - 36 PC (g/lamer

ustang

PC Camera Driver Installation

1

aroN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.

Click Option Drivers (button).

Click 2.Install WebCam Driver > Yes.

Choose the language you prefer and click Next > Next > Finish.

Run the camera application program from the desktop shortcut (if the hard-
ware is turned off use the Fn + F10 key combination to turn it on again).

FMPLE,
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PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

Click Start, and click Control Panel (or point to Settings and click Control Panel).

Click Sound (Hardware and Sound).

Click Recording (tab).

Right-click Microphone (Realtek High Definition Audio) and make sure the item is

not disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.

Click OK and close the control panels.

Run the camera application program from the desktop shortcut.

9. Go tothe Devices menu heading and select Microphone (Realtek....) (it should
have a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick

alongside it).

o bk

~

©
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Figure7 - 27
Audio Setup for PC J e [ T
Camera S ek s g i 1 i bt L e
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Camera Application
The cameraapplication isavideo viewer for general purpose video viewing and test- 4

ing, and for capturing video filesto .avi format. _ _
Pre-Allocating File

1. Runthe camera application from the desktop shortcut (it is recommended that you SIAEEEE
set the capture file before the capture process - see below). You may pre-allocate the
2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera file size (File > Allocate
Audio Setup” on page 7 - 37) and select Start Capture. File Size/Space) for the
3. Click OK/Yes (the file location will be displayed in the pop-up box) to start capture file in the camera
capturing the video, and press Esc to stop the capture (you can view the file using program (you may need

to set a folder location
first).

Set Capture File Pre-allocating space on

Prior to capturing video files you may select the Set Capture File... option in the me hardtdis" Canl_itmp(ro"e
. ) X L . e capture quality (par-
Filemenu, and set thefile name and location before capture (thiswill helpavoidac- | o 0" of Targe capture

cidentally overwriting files). Set the name and location then click Open, thensetthe | fies), by reducing the
" Capturefilesize:" and click OK. Y ou can then start the capture processasonthe | amount of work the hard

previous page. disk has to do in finding
space for the video data

as it is being captured.

the Windows Media Player).

Notetheimportant information in “Reducing Video File Size” on page 7 - 40in

order to save file space, and help prevent system problems. See also “Reducing Vid-
eo File Size” on page 7 -
40.
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problemsit is recommended that
you save the captured video file to alocation other than the C: drive (see“ Set Cap-
ture File’ on page 7 - 39), limit the file size of the captured video (see “ Pre-Allo-
cating File Size/Space” on page 7 - 39) or reduce video resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.
7 - 40 PC Gamera Madule,



Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to

adjust the setting in the Video Capture Filter options. Latest PC Camera

1. Run the camera application from the desktop shortcut. Driver Information

2. Goto Options and scroll down to select Video Capture Filter.... Erea i B B
3. Click either 50Hz or 60Hz under Frequency (Anti Flicker). ers & Utilities + User’s

Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured here.

‘Wejec Proc Smo  (Camem Cortel

Brighinesa

Figure7 - 28
Video Capture Filter
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Taking Still Pictures

7\11/: The camera application alows you to take still pictures.
Snapshot Folder 1. Run the camera application from the desktop shortcut.
2. Goto Options and select Take Picture. r'
WIS SIEREIGE R CICEESEl 3. The picture (in JPEG format) will be placed in the Snapshot folder #88 on the
default location is on the desktop.

desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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TV Tuner Module

If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with aremote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows 7 (not included
in Starter or Home Basic versions). A driver is provided on the Device Drivers &
Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner alows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner moduleis
installed. Make sure you connect the TV antenna.

TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please

do not use your TV Tun-
er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure7-29
TV Tuner Ports/
Jacks

1. Consumer Infra-
red Transceiver

2. CATV Antenna
Jack

TV Tuner Module 7 - 43
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TV Tuner Module
Support

Note that the TV Tuner
module options in Win-
dows 7 is supported by
the Windows Media
Center software which
comes built-in to all the
Windows 7 versions
except Starter and
Home Basic.

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install any
Windows 7 version ex-
cept Starter and Home
Basic.

7 -44 TV TMner

ustang

Consumer Infrared Driver

1

arowN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 3.Install CIR Driver > Yes.

Choose the language you prefer and click Next > Next.

Click Finish to restart the computer.

Windows Media Center

This TV Tuner module is fully supported by Windows Media Center in
Windows 7 (not included in Starter or Home Basic versions).

Run Windows Media Center directly from the Start menu (Start > Pro-
grams > Windows Media Center).

Windows Help and Support provides information on the Windows M edia
Center functions. Click Sart [ and select Help and Support, and then
type “Media Center” in the Search Help box and click the magnifying
glassicon £ to bring up the results.

(959 H(!teebook



Digital TV Broadcast Signal

The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal isweak then no picture will appear onthe TV at all.

TV Recording and Power Plans

If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “ Power Plans’ on page 3 - 4)
to prevent the power saving options from adjusting the computer’ s performance lev-
el.

Remote Control Unit

Theremote control unit allowsyou to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over al TV and video
functions.

CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer's attention
to Article 820-93 of the
NEC (Section 54, Part |
of the Canadian Electri-
cal Code).
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User Pinning
Support

If the Turbo Memory
module supports User
Pinning then the Intel
Turbo Memory Dash-
board will be installed. If
the Turbo Memory mod-
ule does not support
User Pinning then the
Intel Turbo Memory
Dashboard will not be
installed.

7 - 46 InteIM'EytgnngvMOe

Intel Turbo Memory Module

If you have included an Intel Turbo Memory (Robson) NAND flash memory card
modulein your purchase option, theninstall the driver asinstructed below. However
if you have setup your hard disksin RAID mode you may have already installed this
driver (see*” Setting Up SATA RAID Mode” on page 7 - 2).

Intel Turbo Memory Technology (also known as Robson flash memory) isan Intel
technology that reduces the time it takes for a computer to boot up, to load applica-
tions, and to write data to the hard drive.

Intel Turbo & Matrix Storage Setup and Driver Installation

1.

OOk wN

~

N

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 4.Install TM&iMSM Driver > Yes.

Click Next > Next > Yes > Next.

Click Finish to restart the computer.

For Turbo Memory modules that support User Pinning see “Intel Turbo
Memory Dashboard (User Pinning Supported Only)” on page 7 - 47.
For Turbo Memory modules that do not support User Pinning see” I ntel
Turbo Memory Console” on page 7 - 50.

mor kModule



Intel Turbo Memory Dashboard (User Pinning Supported Only)
The Intel Turbo Memory Dashboard allows you to pin an application or file to
load into the Intel Turbo Memory NAND cache for performance acceleration.

1.

2.

Run the Intel® Turbo Memory Dashboard from the Programs/All Programs
menu (Intel® Turbo Memory) or from the desktop shortcut.

The Pinning Capacity Consumption Meter @ displays the amount of pinning
space used.

The Control and Profile Pull-Down Menu @ allows you to select and manage
profiles.

The Application Window © lists all applications available for performance
acceleration. When accelerated the applications/files will appear in the
Accelerated Window @.

The Custom Sets Window @ allows you to select specific files to be pinned.

=
! o TIntelmTurnd Memcry i
- Clchbwiars mz - @

5

- R

Modules

4

Help

Click the Help icon n to

bring up the menu and
click to select and help
topic.

Figure7 - 30
Intel Turbo Memory
Dashboard

Intel Turbo Memory Module 7 - 47
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Pinning an Application

4 + 1. Thelntel® Turbo Memory Dashboard allows you to select files and
applications to accelerate and therefore open faster and display quicker.

2. Applicationswill be listed in the Applications Window on the right.

3. To accelerate any application drag the icon into the Acceler ated pane on

Click the application in the left (the available memory isindicated in the top left).

the Accelerated Win- PET . .
dow and drag it back to 4. A status bar indicates the pinning progress and will turn green when readly.

the Applications Win-
dow to unpin the appli-
cation.

Unpinning an
Application

f; = IntelwiTurbo Memary
\ A (intel

You can also unpin the
application by right-
clicking it in the Appli-
cations Window and
selecting “Remove
from Cache.”

T SRR ... . -

HACTEa s T CETIiS COeF S 00T
J ¥ 1 P surch STmmat Gaplkorer Drawnr
% -

E |:I:l YirmeH T InfoPsils 2500 Mrde Lygdarar

L]
E I—'I MUTORHDL IO sy 2001 ﬂ ' Marnia | [agreetios
i
. |

Figure7 - 31
Accelerated ) (] e omes s 0m | At
Applications
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Custom File Sets

A Custom File Set alows you to group applications and files to accelerate. These
sets can be moved easily in and out of the Accelerated Window which is of benefit
when space islimited. Y ou need to create the custom file set before dragging the set
to the accelerated window.

Click Custom File Sets and type a name for the set, and then click Next.
Select the file set folder icon and click Advanced.

Click the Browse button and select the files and applications to accelerate.
Click the Done button when finished.

Drag the custom set across to the Accelerated Window from Custom File

Setsto accelerate. -
. FF = |
7\ IntelzTurbo Mamory i e
F R | = @
| Figure7 - 32

e Vi ek e Create Custom File
Set

grwdE

] e Brewnr® b s in
! i s
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Intel Turbo Memory Console

4 . 1. Runthelntel® Turbo Memory Console from the Programs/All Pro-
s grams menu (Intel® Turbo Memory).
2. You can enable/disable Windows ReadyBoost and Windows ReadyDrive

ReadyBoost

from the Intel® Turbo Memory Console.

If your module supports
User Pinning (i.e. the
Intel Turbo Memory
Dashboard is installed)
then ReadyBoost is
not supported (the item
will be grayed out).

Figure7 - 33
Intel Turbo Memory
Console

» Windows ReadyBoost - uses flash memory as a hard-drive caching solution

(Not supported if User Pinning is supported).
* Windows ReadyDrive - uses hybrid drives as a hard-drive caching solution.
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HDMI-In Module

The optional HDMI-In module allows you to display external sources such as Blu-
ray players, DVDs, set top boxes and games consoles etc. on your computer screen.
Install the driver asindicated below.

HDMI-In Driver
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).
Click 5.Install HDMI In Driver > Yes.

Click Next.

Click Finish (the application will prepare to install).
Click Next > Install.

Click Finish.

The GameM ate application will appear on the desktop.

© NGk WDN
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™ GameMate Media Player (HDMI-In)
7£l< The GameMate Media Player allows you to play content from digital sources
GameMate Media through the HDMI-In port.

Player and Power-
Saving States

1. Connect your digital source to the HDMI-In port using an HDMI cable.

2. Access the GameMate Media Player from the desktop shortcut or from

If the computer enters GameMate folder in Program Files.

Sleep or Hibernate 3. Press play on any attached digital source player (or use a remote control to
mode while running the navigate the menus of consoles etc.).

CEpEVE R ERSEVERE 4. The picture will appear in the GameMate Media Player.
er, the program will stop
running, and will need to
be restarted when the
system resumes from
the power-saving state.

Figure7- 34
GameMate Player
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Double-click the GameMate screen to toggle through different screen size options.
Y ou can also right-click the screen to access the configuration menu to adjust any of
the following settings:

RENDERED QUALITY
Select High, Medium or Low quality from this menu item.

REMDERED QUALITY b| & HIGH
STANDARD b R
LOwW
STANDARD
Select NTSC or PAL standard from thisitem.
STAMDARD v v NTSC
FORMAT b —
FORMAT
Select the screen format here (only supported resolutions will be shown).
STAMDARD b v NTSC
FORMAT b —
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ASPECT

The Aspect item allows you to select standard or wide screen aspect ratios.
ASPECT » 4:3
SNAPSHOT [ BMP ) ¥ ]| 16:3

SNAPSHOT
Click either the BMP or JPG items to take a screen shot of the current GameM ate
screen (the file will be placed in the Pictures library folder in Windows).

SMAPSHOT (BMP )
SMAPSHOT (IPG)

TOPSHOT
If enabled then the GameM ate screen will remain on top of other windows.

¥ | TOPMOST
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Fingerprint Reader Module

Thefingerprint reader Protector Suite Softwar e providesahigh level of security _
for your computer. A further level of security and control is provided in the BIOS Password Warning
(see Security Menu” on page 5 - 13). If you set passwords for
any of the security mod-

Thefingerprint reader and Protector Suite Software allow you to: ules, NEVER forget your
assword.

» Accessor Lock your computer .

» Protect sensitive files The consequences of

this could be serious. If

» Display and file your favorite web pages you cannot remember

* Fillin frequentlly used Qialpgs your boot password you
* Run your favorite applications must contact your ven-

. . . . . . dor and you may lose all
If you have included the fingerprint reader in your purchase option you will need to B e e ol

install the driver as per the instructions below. your hard disk.

Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment processit is recommended that you go through the
fingerprint tutorial (see Figure 7 - 35 on page 7 - 57).
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7 - 56 Flngﬁrganlg 650

Fingerprint Reader Driver Installation

1

SUurWN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers.

Click 6.Install FingerPrint Driver > Yes.

Click Next > Next > Next.

Click Finish > Yesto restart the computer.

Click the tray icon [, scan afinger or click Start > Programs/All Pro-
grams > Protector Suite > Control Center and then begin the enrollment
process (see over).

d r Module
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User Enrollment

1. Click Start > Programs/All Programs > Protector Suite > Control Center, or
double click the taskbar icon (click Initialize).

2. On the first run of the program you will be asked to click the Accept button to Elr?rgo(lalrrz:x
accept the license.

3. If you have not set a Windows password you will be prompted to do so (hote: If Note that it is strongly rec-
you have not set a password Protector Suite cannot secure access to your ommended that you enroll

more than one finger in
case of injury etc.

computer).

4. Click Submit when you have entered password.

5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get
help with fingerprint enrollment at any time).

N WL

Figure7 - 35
Fingerprint
Enrollment
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6. Click the button above any of the fingers to begin the enroliment process for that
_ZX_ finger.

e 7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
Fingerprint =

Enrollment
Crowel CedyrHorew & hige g Fegeepeingy

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

B Yot e iy e 1R o cxrg e rrgmped e

Errol | rnasind

Figure7 - 36
Fingerprint
Enrollment

Progress

Frmr = apurm mdE fer preemey e mgasies RS

8. Close the Protector Suite 2009 window.
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9. Right-click the taskbar icon E and select Start Control Center (and then swipe a
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and
access the Help menu etc. You can also run the Control Center etc. from the
Protector Suite item in the Programs/All Programs menu

10. Click “Help” to get more information on any topic.

11. You can also run the Tutorial, or Product Tour video to get more information.

Figure7 - 37
Control Center &
Biomenu

12. If you swipe your finger over the reader at any time you can access the Biomenu
to lock the computer, register websites, access the Personal Safe, open the
Control Center and access the Help menu.

.|
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4

Help

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.

Fingerprint Control Center Features

Application Launcher

The Application Launcher allowsyou to register applicationsto be launched when
assigned to a particular finger. Simply copy the application icon on to one of thereg-
istered fingersand ten click OK to close the application window. Onceregistered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc.

Personal Safe
The Personal Safeis an encrypted area assigned on your hard drive that allowsyou
to store files and folders to be protected by fingerprint protection.
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.
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Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sure it is actually working. Check the LED Power Indicators (see“LED Indicators’ on page 1 - 7)
to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Configuring the Power Buttons’ on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 4, on page 1 - 10).

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB stor age devicesin any connected drive
when you start up your machine (this is a common cause of the message “I nvalid system disk - Replace the
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
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Troubleshooting

Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Boot password for the SCU (see “ Security Menu” on page 5 - 13).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief
notes).

\ A/
L&
Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-

ranty.

Mustang W650 Notebook Backup and General Maintenance 8 - 3



Troubleshooting

Viruses

Install an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
gramsto check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).

8 - 4 Viruses
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Troubleshooting

Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don't open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitted “READ ME” or “READ ME FIRST”.

* Wheninstalling a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

* Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.
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Troubleshooting

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Troubleshooting

Problems & Possible Solutions

Problem

Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator {11, is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn't start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4) check its settings. You may also be using an ExpressCard device/USB
device/external device that is drawing a lot of power.

You are attempting to run an SLI configuration on battery power. Due to the high power and
system demands created by enabling SLI Configuration, you should not enable SLI
configuration if your computer is powered by battery only.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4).

A peripheral device/lUSB device is consuming a lot of power. Turn off/remove the unused device
to save power.

Problems & Possible Solutions 8 - 7
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Troubleshooting

Problem

Possible Cause - Solution

The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn't sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure
you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing on

screen.

appears

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations.
If you're connected to an external monitor, make sure it's plugged in and turned on. You should
also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor |
have plugged in and
powered on.

You haven't installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.

8,R835LRl5 Solutions
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Troubleshooting

Problem Possible Cause - Solution
You forget the boot | If you forget the password, you may have to discharge the battery of the CMOS. Contact your
password. service representative for help.

AN
I

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, use the key combination Fn + F5 and F6 or move your finger slowly along the
volume control slider to adjust the system volume (see “Audio Features” on page 2 - 11/
“Touch Sensor Instant Keys” on page 1 - 8) to adjust.

The compact disc

cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.

Problems & Possible Solutions 8 - 9
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Problem

Possible Cause - Solution

The TouchPad doesn't
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes

Power Options features are not enabled. Go to the Windows Power Options menu and enable

into a power saving | the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have
mode. enabled Hibernate mode from the control panel.

The Wireless LAN/ | The modules are off. Check the appropriate LED indicator to see if the modules are on or off (see
Bluetooth/PC Camera | “Touch Sensor Instant Keys” on page 1 - 8). If the LED indicator is not illuminated, then press
modules cannot be | the appropriate touch sensor instant key/function key combination in order to enable the
detected. modules.

The Wireless LAN/ | The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
Bluetooth/PC Camera | for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
modules cannot be | module).

configured.
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Problem

Possible Cause - Solution

When a DVD is played in
Windows Media Player/
Media Center, the audio
track in other languages
(commentaries etc.) is
not clear if connected to
the S/PDIF-Out Jack.

This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-
Out Jack. We recommend that you use the Power DVD application to play DVDs.

Nothing appears on the
screen when the PC
Camera software is run.

You have selected an external display as the default display device. The PC Camera application
software needs to be run while the default notebook LCD is the selected display device.

After a camera picture is obtained on the default notebook LCD, you may then use the Fn + F7 to
toggle through the display modes (give the screen time to refresh).

If you have selected an external display as your display device do not run the PC Camera
software application until you have switched back to the notebook LCD.

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

Problems & Possible Solutions 8 - 11
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Problem Possible Cause - Solution

The  Wireless LAN | The WLAN module is turned off in the Windows Mobility Center. The computer’s wireless
indicators  &¥.) & | function keys will not function properly if Wireless is turned OFF in the Windows Mobility
show that the WLAN | Center control panel. Make sure that Wireless is ON in the Mobility Center to ensure proper
module is powered on, | function key behavior (see “Wireless Hot Keys” on page 7 - 34).

however the module
does not connect.

No sound can be heard | You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page 2 -
through an HDMI | 8.

connected display
device.

You are experiencing | Where this is the case, install the beta video driver version provided on the Device Drivers &

problems with image | Utilities +User’s Manual disc.

distortion in a 3D game

(or any 3D program) | 1. Insertthe Device Drivers & Utilities + User’s Manual disc and click Browse

when the computer is CD/DVD.

powered by the battery. | 2. The driver is located in the following location on the disc:
Drivers\02Video(beta)\.

3. Double-click the executable setup file and follow the on-screen instructions to
install the driver.

8 - 12 Probhjlems\ﬁ%g%ssiblke Solutions
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Problem Possible Cause - Solution

When the battery is being | This can occur as the battery cell performs poorly in a low temperature environment, especially
used to power the system | with a discharge rate of over 2C. Systems powered by the battery will perform normally at
in an environment with an | environmental temperatures over 10°C/50°F. To use the system at environmental temperatures
ambient temperature of | below 10°C/50°F, it is recommended that the system is powered by the AC/DC adapter.

below 10°C/50°F, the
battery reaches a low | Battery Notes:

level very quickly. o ) o
Note that when the the battery capacity is measured it may read less than the 5300mAh indicated

on the label, and possibly less than 5000mAh. This can be due to either of the following factors:

» The battery capacity listed on the label is defined by cell character specification. There
isa-5% capacity tolerance based on atest at 0.2C charge/0.2C discharge. Therefore
5035mAh (-5% of 5300mAh) meets the battery capacity specification listed.

» Thissystem runswith a0.6C charge/1C~2.5C discharge rate. The higher system charge/
discharge rate can result in alower battery capacity measurement reading.
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Problem Possible Cause - Solution

You have a RAID | You may need to recover the RAID volumes.

enabled and the system | 1 Ag the computer starts up press Ctrl + i to enter RAID configuration menu

will not boot to Windows. 2. If the RAID volume’s Physical disks are marked in red, then press 4.Recovery
Volume Options.

3. Ifyou cannot access 4.Recovery Volume Options (i.e. itis grayed out) then press
5.Acceleration Options.

4. Press Enter and return to the main menu, then press 4.Recovery Volume
Options.

5. Follow the on screen instructions to recover the Physical disks.

6. If only one of the physical disks now appears green, then press 6.Exit to save the
changes and exit and boot to Windows.

7. When Windows is loaded run the Intel® Matrix Storage Console from the Intel®

Matrix Storage Manager in the Programs/All Programs menu.

Click View > Advanced Mode.

9. Right-click on the RAID volume and select either Verify Volume Data or Verify
and Repair Volume Data.

10. The verification or verification and repair process will run and display progress.

11. A dialog box will display the final status of the verification or verification and repair
status.

©
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Troubleshooting

Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows M obile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Micr osoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.

3. Make sure the Bluetooth device is powered on.

4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

e TN T -

4.5

Metwork adapters /
'3 Atheros ARS007EG Wireless Network Adapter

l&-"‘ Bluetooth Device (Personal Area Network) . A

& Bluetooth Device (RFCOMM Protocol TD] Bluetooth Peripheral Devices
l;‘ Marvell Yukeon 88E8040 PCI-E Fast Ethernet Controller You will need to repeat the procedure
4-[lp Other devices listed here for all Bluetooth Peripher-

L1l Bluetooth Peripheral Device . . .
S B al Devices listed under Other Devices

7 |lm PCIFLASH Memory

» 3 Processors i.e. until there are no more Bluetooth
»-% Seund, video and game controllers Peripheral Devices listed under this
€7 Storage controllers menu heading_

. Wil Suctarn devicar

|
Figure 8 - 1 - Device Manager
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Troubleshooting

6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

e . et

Figure 8 - 2 - Browse my computer.../Let me pick from...

B 9. Select Bluetooth Radios from the list.

8 - 16 Bluehlj

ooth
ustang

Ko . SpdisDhe Softues - Blaksck Puig hassl Dodes

Gt v devaos's e roem the i) el oy
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B ANV [
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" Figure 8 - 3- Select Bluetooth Radios
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Troubleshooting

10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

{3 . Unitote Drives Softuare - Bt Pesiatennl Devoe

Srlert the device drivssr you vt b ksl for $his hardveane

bt tha rmaredscunm @nd modal of your hendei s dew e and then click Hst. ¥ pou haee s
dick: Tt contsps ihi v piiwand ra ol deck Hisos Dd

[ Y VR S p— = || Wodal

Wliorchknk —giWindowa Mcble-eages der 400 ROl
Make sure you select
Microsoft Corporation

Gl Ths diwer & Sgrtally sagned Hawn Die

sk ST BATEEE 0 e ariant

Figure 8 - 4 - Select Device Driver
13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

Mustang W650 Notebook Bluetooth Connection Problems 8 - 17



Troubleshooting

15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

ﬁ..!rnl-h[l‘ = b =
[ dinken  Siew Hep

o | i (I BT | R | o o

- g, A5

@ e
4 i) R P

i - =T .
] Sreioen Wiokle-te e devion mppe s

o Dbk it
By Ohige mistml
el LPVIVT LRI ey
vl e et e D e
& DL ETRIET R porarcdiim
T Ly e
= bevhaod
M Bt s ol poa i g deeim
dd Y T
B i i
" Pirkaeerh odoplony
= O dere ®
B Perask o s
P Poax (00 UK LFTS
T P
4 Ieuel veim rd gere cord e
W Gy e
W Lol lelid B el el

Figure 8 - 5 - Device Manager - Bluetooth Radio
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
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Interface (Ports & Jacks)

Ports and Jacks

Item

Description

Card Reader

O MMC/SD [ MS

The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible
MS (Memory Stick) / MS Pro / MS Duo

Push the card into the slot and it will appear as a removable device.

Cable (CATV)
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in
your purchase.

Consumer Infrared

The consumer infrared transceiver at the front of the computer allows the computer to

Transceiver communicate with the remote control unit supplied with the optional Mini-PCI TV Tuner.
DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.
DVI-Out Port The DVI-Out (Digital Visual Interface) Port is a video connector interface. This allows you to

connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Configuring
an External Display using the NVIDIA Control Panel” on page B - 7) by means of a DVI cable.
If you are using an older type of monitor you will need to use a converter to convert the signal
from DVI to VGA.

A -2 Interf@&gngF\’A%%sNgLe%gkcks)




Interface (Ports & Jacks)

Item Description
e-SATA Port This e-SATA (external Serial Advanced Technology Attachment) port allows you to plug-in
e-SATA external Serial ATA hard drives.
HDMI-IN Port The HDMI-In (High-Definition Multimedia Interface) port allows you to display external sources
HDMI-IN such as Blu-ray players, DVDs, set top boxes and games consoles etc. on your computer screen

Factory Option

(see “HDMI-In Module” on page 7 - 51). The HDMI-In port is enabled with the optional
(Factory Option) HDMI-In Module only.

HDMI-Out Port
HDMI-OUT

The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector
interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Configuring an External
Display using the NVIDIA Control Panel” on page B - 7) by means of a HDMI cable. Note that
HDMI carries both audio and video signals (see “HDMI Audio Configuration” on page 2 -
8).

Headphone-Out Jack

9

Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Line-In Jack

@»

The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound control panel and make sure the Mute box is not
ticked.

Mustang W650 Notebook
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Interface (Ports & Jacks)

Item

Description

Microphone-In Jack

A

Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394b Port

This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

4

IEEE 1394b
The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices.

RJ-45 LAN Jack

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack

This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

A -4 'nterfﬁ&%nﬁ%
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Interface (Ports & Jacks)

Item Description

USB 2.0/1.1 Ports These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be

USB 3.0 Port plugged into the computer, and unplugged from the computer, without the need to turn the system
off (if the power rating of your USB device is 500mA or above, make sure you use the power
3.0 supply which comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB 3.0 will
transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7), does not
support wake on USB and is not operational under DOS.
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NVIDIA Video Driver Controls

Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
pagel- 17.

NVIDIA Video Driver Installation

Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3.

1.

e

Insert the Device Drivers & Utilities+ User’s Manual disc and click I nstall
Drivers (button).

Click 2.Install Video Driver > Yes.

Click Next > Next.

Click Finish to restart the computer.

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and chang-
es. Check with your service center for the latest details on video cards supported. Note that
not all video card options for this computer model series support SLI configuration (see
“Video Adapter Options” on page C - 2, or contact your service center for details).
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NVIDIA Video Driver Controls
NVIDIA Control Panel (Win 7)

More advanced video configuration options are provided in the NVIDIA Control

4

NVIDIA Control
Panel

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Wimy

Frafila Zartd Banal
Mew

B Sreen mhion
B Cadgets
& Pucnubo

FigureB- 1
NVIDIA GeForce.....
Control Panel

Panel tab.
1. Open the Display (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.
OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).
hm-.-vn-':'l_mm
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The NVIDIA Control Panel provides additiona video configuration controls and
toolswhich allow quick accessto features such as display configuration, 3D Settings

and Help menus etc.

o e

NVIDIA Video Driver Controls

B (= 3 ¥
I- T -,_ — ==

== © L=

= e e
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NVIDIA Control Panel (Win7) B - 3

4

Navigating the
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.

Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

FigureB - 2
NVIDIA Control
Panels



NVIDIA Video Driver Controls

The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

<A nmnm_

I
|
I ‘Control
I

2 SoeR

| M Settngs - Gomes and
| Applcations

| -
|'-I1:':_.:I;JDWHFIIEI-I-U.HH r!

FigureB - 3
Help Menu
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NVIDIA Video Driver Controls

Display Devices

Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI Z
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to Display Devices
connect an external display (if you are using an older type of monitor you canusea | gesides the built-in
converter to convert the signal from DVI to VGA). See your display device manual LCD, you can also use

to see which formats are supported. an external monitor/flat
panel display as your
display device. The dis-

1. The built-in LCD. play options are:

2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the The built-in LCD.

HDMI-Out Port. An external display
connected to the DVI-

Monitor and TV Tuner

Out port.

An external display
connected to the
HDMI-Out port.

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aer-
ial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled.
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NVIDIA Video Driver Controls

- Display Modes

SLI Configuration & SISV M_Ode _
Multiple Displays Only one of your displaysis used.

Note that if SLI configu-

o Duplicate Displays
ration is enabled only a . . . .
S e Duplicate ssimply shows an exact copy of the Primary display desktop on the other
CEEEREERGERC R EGES  display(s). This mode will drive multiple displays with the same content.
vice.
slel\loppin i S E il Extend Desktop
s C el Extend Desktop treats both connected displays as separate devices, and they act as
Wl ERIEVAR g virtual desktop resulting in a large workspace. When enabled, you can drag any
2&? d”ssvﬁ’rggpi'c;:t':oirl; icons or windows across to the other display desktop. It is therefore possible to have
S sk o 8 oneprogram visiblein oneof the displays, and adifferent program visiblein the oth-
tempting to " configtre” AT
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
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NVIDIA Video Driver Controls

Configuring an External Display using the NVIDIA Control Panel

Y ou can use the NVIDIA control panel to configure any attached displays. a

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on. Display Not Shown
2. Goto NVIDIA Control Panel (see page B - 2).

3. Double-click Display (if the sub-menus are not visible), and then click Set up If the attached display
multiple displays. does not appear in the
4. Any attached display will appear under “1.Select the displays you want to use.” sseed e dleple
you want to use.” win-
m dow, click “My Display
- Rl = I e =—u-- is not shown..” and
"".':',, e .;|_',1 i #Hmﬁmﬂ e then click the appropri-
; il i s b ol B g sy ate button to force de-

tection of the missing

- display.

Y Y P R L

FigureB- 4

Set Up Multiple
Displays E

[ P —

5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save any changes made.
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NVIDIA Video Driver Controls

Duplicating the Displays

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.

2. Goto NVIDIA Control Panel (see page B - 2).

3. Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

4. Any attached display will appear under “1.Select the displays you want to use.”

5. Click the tickbox alongside any display you wish to use.

6. Right-click one of the display icons and click “Duplicate displays....” (select which
is to be the primary display) to duplicate the desktop on both displays.

i LR s [ e Y TRESLE S
= [ et Up Muitiple Dol o
FigureB -5 T T —
Duplicate A— -
. e AN G e e
DlSpIayS lllll L = by P iy

ST T dmrs e

'Right-click to sel
and whichistob

Select Apply > Yes
to save changes

7. Click Apply > Yes to save any changes.
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NVIDIA Video Driver Controls

Extending the Display

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.

2. Goto NVIDIA Control Panel (see page B - 2).

3. Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

4. Click to select a primary display under “1.Select the displays you want to use.”

5. Right-click one of the display icons and click “Extend Desktop on this display....”
to extend the desktop across both displays.

Select Apply > Yes )
to save changes FigureB -6

=] Extend the Display

e . i by

[ ESS——

i

Right-click Extend desktop on this display
i i e

6. - Click- Apply > Yes to save any changes.
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NVIDIA Video Driver Controls

FigureB -7
Switch Primary
Display

Changing the Primary Display on Extended Displays

1. If you want to switch the primary display if the displays are extended then right-

click the secondary display icon.
2. Select Make this the Windows primary display.
3. Click Apply > Yes to save the change.

b o) | [AH ety

s Se U Displays

S ALy TS e L I Y i e e e I e e NS

g wy e Mmooy

1. ek o ol s e o et e

) — to savefEhanges

P mreeiL LONEr

e 1 Tk

ight—click to select the secondary display
and select Make this the Windows primary display.
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NVIDIA Video Driver Controls
Attaching Other Displays (Win 7)

Configuring an External Display in Windows 7

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Gotothe Screen resolution control panel.

3. Click the Detect button. I:“c%am”b‘:::ﬂt::t';qo* FIZ
4. The computer will then detect any attached displays. thr)c')ugh thel display ggp_
tions:

4

Function Key
Combination

w Cplay ¢ Tevas Aescduten * Notebook Only
= « External Display Only
* Notebook + External

Display

Chang® the appeardnce of your dsplay

Make sure you give the
displays enough time to

refresh.
Bt (3 Maiis vty <1 DO NOT use the Fn + F7
key combination to toggle
Rersfuhigy [0 ] through display options
1o SR e e i Ed when SLI is enabled.
i pledmisre II'.I-\.-IEHIJ‘\-Hi-:\IIﬂI.I;l -
Thep b csrrenily pror i i ey, Fop e 7 e
T SR T S ST P e T e PSSR F|gure B - 8
e e Screen Resolution
Multiple Displays
Lr (=113 1 (W|n 7)
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NVIDIA Video Driver Controls

5. You can configure the displays from the Multiple Displays menu.

W = Dopley b Sorman Ancduaen | &y
Chaen s thie gpgieorances o your disnlag
‘ [
FigureB-9
Screen Resolution Moy L et oo 0 |
Multiple Display Bl loa= =)
Options Cmprdpare Vﬂaﬁ_\\
(Win 7) Buliplu by

This I sanandy o Eaired feos dplyd
Sheer dadkzag andy e 1

L Elﬂ!‘dﬂ ane o 3
P | wad ad pehan

Wi SOy BRI g b el A il CTiCr D

1 (=8 Coarecad |
4

» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)

» Extend these displays - Treats both connected displays as separ ate devices

» Show desktop only on 1/2 - Only one of your displaysis used.
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NVIDIA Video Driver Controls

Using the Windows Logo Key & + P Key Combination to Switch Displays

You can also usethe & + P key combination to quickly change display configura-
tion and modes (thisis particularly useful when attaching a projector) in Windows 7.

Attach your external display to the external monitor port and turn it on.

Press the & + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or s + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PoNE

Dsconnect Projector | Duplicates Exberd Progecior ordy Figure B-10
i Coniguraion
_g Configuration
| i Selection
(Win 7)

. |
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NVIDIA Video Driver Controls

SLI Multi GPU Configuration

4
Ve . This computer features an NVIDIA Scalable Link Interface (SLI) that improves
IOe?i oc;'g graphic quality and performance by combining dual NVIDIA GPUs (two video

P cards are required) in asingle system. To enable/disable SLI Configuration:
Note.f'that. card :iyggs, 1. Goto NVIDIA Control Panel (see page B - 2).
specifications and driv- 2. Click “+" next to 3D Settings if its sub-items are not shown and then click Set SLI
ers are subject to con- : :
tnual updates and and PhysX configuration.
changes. Check with N p=
your service center for |"-:'_ M R bl e |
the latest details on | FE o T AT LA w. | SelectRestart Now
video cards supported. et ‘ ] to restart the computer
Note that not all video | o
card options for this - e = -
computer model series | o | T —— -
support SLI configura- e T TR s '
tion (see “Video i e ikt kel ' el
Adapter Options” on e :
page C - 2, or contact s o —a
your service center
for details). -

L= =
FigureB- 11 Click “Maximize 3D Performance” under “SLI configuration:”.
Set SLI

Click to select “PhysX settings; Auto-select (recommended) is the default setting.
Click Apply and Restart Now to restart the computer (see over).

o w

Configuration

B - 14 SLI b(lulti (\K‘a/g;yNggnfiguration
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NVIDIA Video Driver Controls

SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Con-

SN
L&

figuration, you should not enable SL | configuration if your computer ispowered B SISRSERITeFIE RS
Multiple Displays

by battery only. If you attempt to run an SLI configuration when the computer is
powered by the battery only, then system problems may occur. Note that if SLI configu-
ration is enabled only a

« |f the computer is currently powered by battery only do not enable SLI config- [ SielEREiE s EVIEEE
used as the display de-

uration. vice.
« If you have currently enabled SLI configuration, and the computer is powered DO NOT use the Fn +
by the AC/DC adapter, do not switch to battery power only (or go to the LG Gl 1Y
. . . LY toggle through display
NVIDIA Control Panel and disable SLI configuration before switching to bat- options when SLI is en-
tery power only). abled. SLI supports only

a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
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NVIDIA Video Driver Controls

4

Detect Displays

To get a full range of dis-
play options click “My dis-
play is not shown in the
list...”.

HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page 2 -
8 for instructions on con-
figuring audio for HDMI
display devices.

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

FigureB - 12
Set Up Multiple
Displays
(with TV connected)

B - 16 EnaBIing 'IV:/ 5&)'3&[@
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Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an
HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI1-Out port (if sup-
ported by your TV).

Y ou will need to enable the TV display from the NVIDIA Control Panel as per the
instructionson B - 7. The TV will appear as adisplay option (1. Select the displays
you would like to use.) when attached to the appropriate port. Apply the settings,
and then click Y esto save the changes.

[o]



NVIDIA Video Driver Controls

Changing the TV Signal Format

1.
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Mustang W650 Notebook

When the TV is enabled as a display device click the sub-menus under Video &
Television.
Click “Change the signal or HD format”.
Select the connector or format you want to use (the menu that appears will depend
upon your type of connector).
Apply the settings, and then click Yes to save the changes.

FigureB - 13
Change the Signal or
HD Format

Enabling TV Display B - 17



NVIDIA Video Driver Controls

TheNVIDIA Control Panel providesadditional configuration controlsto adjust the
TV settingsin the Video & Television menu.

FigureB- 14 =
NVIDIA Control —
Panels
(Video &
Television)

B - 18 Enapling, L:RIsRIaY



Specifications

Appendix C: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
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Specifications

Intel® Core i7 Processor:

975 (3.33GHz)
6.4 GT/s on QPI, 8M L3 Cache, 45nm (45
Nanometer), LGA1366 Package, TDP130W

950 (3.06GHz)
4.8 GT/s on QPI, 8M L3 Cache, 45nm (45
Nanometer), LGA1366 Package, TDP130W

930 (2.8GHz)
4.8 GT/s on QPI, 8M L3 Cache, 45nm (45
Nanometer), LGA1366 Package, TDP130W

920 (2.66GHz)
4.8 GT/s on QPI, 8M L3 Cache, 45nm (45
Nanometer), LGA1366 Package, TDP130W

Intel® X58 + ICH10R

17.3" (43.94cm) FHD (1920 * 1080), 16:9
Wide Screen LED Backlit LCD

Triple Channel DDRIII (DDR3)

Three 204 Pin SO-DIMM Sockets
Supporting DDRIII (DDR3) 1066MHz/
1333MHz Memory Modules

Memory Expandable up to 12GB
Compatible with 1GB, 2GB or 4GB Modules

nVIDIA® GeForce GTX 480M (100W)
SLI PCle Video Card

2GB GDDR3 Video RAM On Board
Supports PCle * 16

Supports Microsoft DirectX® 11.0
Supports HDCP

Supports HDMI 1.4

Supports SLI

SUPPORTS DVI Dual Link

nVIDIA® GTX 460M PCle * 16 Video
Card

1.5GB GDDR5 Video RAM on board
Supports Microsoft DirectX® 11
Supports HDCP

Supports DVI Dual-Link

Supports OpenGL 3.1

One 16Mb Flash ROM
Phoenix™ BIOS

Up to three (Factory Option)
Changeable 2.5" 9.5 mm (h) SATA
(Serial) Hard Disk Drives supporting
RAID level 0/1/5

One 12.7 mm Super Multi/Blu-Ray
Combo/Blu-Ray Writer SATA Optical
Device Drive (Factory Option)

Intel® Turbo Memory 4GB Mini-Card with
PCle Interface
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High Definition Audio

S/PDIF Digital Output

UAA (Universal Audio Architecture)
Built-In Microphone

5 Built-In Speakers and One Sub woofer
Dolby Home Theater Certified

Full Size Winkey Keyboard with Numeric
Keypad

Built-In TouchPad (with Multi Gesture
Functionality)

Touch Sensor Instant Keys

(Mute, Vol Control, Bluetooth, WLAN &
Camera)

Mustang W650 Notebook

Two USB 3.0 Ports (No DOS Support)
Three USB 2.0 Ports

One HDMI-Out (High-Definition
Multimedia Interface) Port-1.4 (with
HDCP Support)

One HDMI-In (High-Definition Multimedia
Interface) Port (Factory Option)

One DVI-Out Port (with CRT out)

One eSATA Port

One S/PDIF Out & Surround Out Combo
Jack (supporting external 7.1ch audio)
One Headphone/Speaker-Out Jack

One Microphone-In Jack

One Line-In Jack

One Mini-IEEE1394b Port

One RJ-45 LAN Jack

One DC-In Jack

One CATV-In Jack (for TV Tuner)

One Consumer Infrared Transceiver for
TV Tuner Remote Controller

Specifications

Three Mini Card Slots:

Slot 1 for PCle WLAN Module

Slot 2 for PCle TV Tuner Module OR
PCleTurbo Memory Module

Slot 3 for One HDMI-In Module

Embedded 9-in-1 Card Reader
- MMC / RSMMC
- SD/ Mini SD/ SDHC/
SDXC Compatible
- MS / MS Pro / MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.
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Specifications

Built-In 10/100/100 Base-TX Ethernet LAN

Bluetooth 2.1 + EDR (Enhanced Data
Rate) Module (Factory Option)

Intel® WiFi Link 6200 1 * 2 (802.11 a/g/n)
Half Mini-Card PCle WLAN Module
(Factory Option)

Intel® WiFi Link 6300 3 * 3 (802.11 a/g/n)
Half Mini-Card PCle WLAN Module
(Factory Option)

3rd Party 802.11b/g/n Wireless LAN PCle
Interface Half Mini-Card Module (Factory
Option)

3.0M Pixel PC Video Camera Module
with USB Interface

HDMI-In Module (Factory Option)

Hybrid TV Tuner Module (Factory
Option)

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module

Windows® 7

Note that the TV Tuner module (factory)
option in is supported by the Windows
Media Center software. Windows Media
Center is not included in Starter or
Home Basic versions of Windows 7.

Supports Wake on LAN
Supports Wake on USB
(for USB 2.0 Only)

Full Range AC/DC Adapter — AC in 100 -
240V, 50 - 60Hz DC Output 20V, 15A
(300 Watts)

Removable Polymer Smart Lithium-lon
78.44Wh Main Battery

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

419mm (w) * 286mm (d) * 60.7mm (h)

5.5kg with Single nVIDIA® GeForce GTX
480M Video Card, ODD and 78.44Wh
Battery
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